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2 Limited Warranty 
 
Bluefish444 warrants that this product will be free from defects in materials and workmanship for a period of three (3) years 
for category A products and two (2) years for category B products from the date of purchase. This warranty is provided only 
to customers who register the Bluefish444 serial number at the place nominated on the Bluefish444 homepage. If a product 
proves to be defective during the warranty period, Bluefish444, at its option, will either repair the defective product without 
charge for parts and labor, or will provide a replacement in exchange for the defective product. 
 
In order to obtain service under this warranty, the customer must notify Bluefish444 of the defect before the expiration of the 
warranty period. The customer shall be responsible for packing and shipping the defective product to a designated service 
centre nominated by Bluefish444 with shipping charges prepaid. The customer will be responsible for shipping charges and 
duties payable on return of the repaired or replaced product to the customer’s address. The customer must provide 
Bluefish444 with details of its nominated international courier company. 
 
This warranty shall not apply to any defect, failure or damage caused by improper use or improper or inadequate 
maintenance and care. Bluefish444 shall not be obligated to furnish service under this warranty a) to repair damage resulting 
from attempts by personnel other than Bluefish444 authorized resellers to install, repair or service the product, b) to repair 
damage resulting from improper use or connection to incompatible equipment, c) to repair any damage resulting or 
malfunction caused by the use of non Bluefish444 parts or supplies, or d) to service a product that has been modified or 
integrated with other products when the effect of such a modification or integration increases the time or difficulty of servicing 
the product. 
 
This warranty specifically shall not apply to Bluefish444 products purchased second hand  
This warranty is given by Bluefish444 in lieu of any other warranties, expressed or implied. Bluefish444’s responsibility to 
repair or replace defective products is the whole and exclusive remedy provided to the customer for any indirect, special, 
incidental or consequential damages. 
 
Category A 
 
2K|Lust, HD|Fury, 2K|Vengance, 2K|Iridium, 2K|Iridium XP 
SD|Greed, SD|Dual Link Pro, SD|Lite Pro, Iridium AV Pro, SD|Single Link Pro, SD|Ingest Pro 
 
Category B 
 
SD|Fidelity, SD|Prime, SD|Focus 
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3 Support Contact Details. 
 
 
Before contacting Bluefish444 Support, please contact your system integrator reseller. 
If you have any questions please contact support at support@bluefish444.com. 
Email Support is free for the life of the warranty. 
 
For phone support you must register your product at; 
http://www.bluefish444.com/support/techsupport 
 
In order to speed the resolution of your problem, please ensure that you provide the following information when contacting 
support. 
 

• Bluefish444 Product and serial number. 
• System configuration and manufacture, Mother board type and Devices installed. 
• SCSI or RAID controller card type. 
• Storage array configuration. 
• OS version. 
• Applications installed. 
• Symmetry; 

o Symmetry logs – please refer  the Symmetry manual on how to obtain logs 
 
For phone support and access to other support resources, hardware configurations etc please register your card at the 
following website link; 
 
http://www.bluefish444.com/products/warranty/register.asp. 
 
 
Bluefish444 technical support; 
 
World    support@bluefish444.com 
North America   support-usa@bluefish444.com 
Europe   support@bluefish444europe.com 
 
Australasia / APAC 
9am to 5pm 
(GMT+10 hours) 
ph +61 3 9682 9136 
support@bluefish444.com 
 
North America 
9am to 5pm 
(GMT -5 hours) 
ph 775-727-6950 
support-usa@bluefish444.com 
 
Europe 
9am to 5pm 
ph +44 (0)20 8868 2575 
support@bluefish444europe.com 
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4 Introduction 
Used in over 100 Hollywood features including several of this years academy award winners, 
 
Bluefish444 I/O solutions deliver the highest standard in capture, playback and broadcast every time. The perfectionist’s 
choice in RGB and DI, Bluefish444 delivers superior results for significantly less on all digital post and broadcast demands. 
 
Renowned for their robust stability and seamless workflow, Bluefish444 are the card of choice under the bonnet of many of 
the industries leading OEM DI solutions. Supporting the widest range of industry standard formats of any I/O solution from 
8bit YUV and 10bit RGB. 
 

 

 

2K | Iridium XP 
 
Designed for digital artists, colorists and professional solutions 
requiring 2K, HD/SD output only for the highest quality in 
broadcast monitoring and Digital Cinema 

HD | Fury 
 
The Single Link HD|Fury is the card of choice for HD/SD editing 
with 2K frame format support and 8 channels of digital audio, 
the HD|Fury provides video output preview for Adobe After 
Effects, Eyeon Digital Fusion, and Autodesk Combustion. 

2K | Lust  
 
A High Definition and true 2K resolution capture and playback 
card, the dual link 2K|Lust is the best way to bring true film quality 
to the desktop. With SD down conversion and 8 channels of 
digital audio, 2K|Lust is the perfect choice for the demanding DI 
market 
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4.1 2K|Lust 

A High Definition and true 2K resolution capture and playback  card, the Dual Link 2K|Lust is the best way to bring 
true film quality to the desktop. With SD down conversion and 8 channels of digital audio, 2K|Lust is the perfect 
choice for the demanding DI market.  
 

• Digital Intermediate - Dual Link I/O DCC. 
• Color Correction & Compositing Conform. 
• Grading. 
• Review & Preview. 
• DC Video Servers. 
• Character Generators. 
• Logo Insertion. 
• Titling & Virtual Set. 

 
Features 

• 2K, HD/SD SDI I/O. 
• 10/8 bit RGB/YUV. 
• DPX, Cineon, Targa RGBA, AVI & QuickTime V210 support 

(AVI, QuickTime not supported in 2K modes). 
• Dual link 4:4:4, 4:2:2:4, 4:4:4:4 I/O. 
• Single link 4:2:2 I/O. 
• Real-time hardware color space conversion. 
• Hardware overlay for internal keying. 
• 8 channels of S/P DIF audio I/O. 
• Real time hardware Broadcast quality up/down/cross conversion 10 bit YUV 4:2:2 preview. 
• Genlock. 
• Symmetry software included. 
• 2048 X 1556 resolution at HSDL frame rate for telecine and film scanners. 
• 2048 X 1080 resolution at 24p/psf frame rate for digital cinema. 
• Additional monitoring BNC connector for simultaneous real time scaling (up and down conversion), 

cropping, windowing, aspect ratio correction and 3:2 pull down of the 2K output signal,(including HSDL & 
Panavision) as HD SDI or SD SDI, including widescreen. 

• 3 X 1D dedicated LUT’s for viewing LOG images as Linear and for color calibration on an HD/SD 
broadcast monitor. 

• VANC (digitized 3 line VITC) support for time code and key code within the SDI signal. 
• An intuitive feature control application to set the hardware scaling, panning & windowing parameters and 

the loading of antilog files. 
• All features available via the Bluefish444 SDK 5.5.X and above. 
• 3 year warranty. 
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4.2  2K|Iridium XP 

Designed for digital artists, colorists and professional solutions requiring HD/SD or 2K output only for the highest 
quality in broadcast monitoring and Digital Cinema. 

 
• DCC, Color Correction & Compositing. 
• Conform & Preview. 
• Video Servers. 
• Character Generators. 
• Titling & Virtual Sets. 

 
Features 

• 2K, HD/SD SDI Output. 
• 10/8 bit RGB/YUV. 
• DPX, Cineon, Targa RGBA, AVI & QuickTime V210 support 

(AVI, QuickTime not supported in 2K modes) 
• Dual link 4:4:4, 4:2:2:4, 4:4:4:4 Output. 
• Single link 4:2:2 Output. 
• Real-time hardware color space conversion. 
• Video and Key Output. 
• Real time hardware Broadcast quality up/down/cross conversion 10 bit YUV 4:2:2 preview. 
• Look Up Table (LUT) support. 
• Aspect  ratio correction & 3:2 pull down support. 
• Genlock. 
• 3 year warranty. 
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4.3 HD|Fury 

The HD|Fury is the card of choice for HD/SD editing with 2K frame format support and 8 channels of digital audio, 
the HD|Fury provides video output preview for Adobe After Effects, Eyeon Digital Fusion, and Autodesk 
Combustion. 

 
• Digital Intermediate. 
• DCC, Color Correction & Compositing. 
• Conform & NLE. 
• Video Servers. 
• Character Generators, Logo insertion. 
• Titling & Virtual Set. 

 
Features 

• 2Kx1080, HD/SD SDI I/O. 
• 10/8 bit RGB/YUV. 
• DPX, Cineon, Targa RGBA, AVI & QuickTime V210 support 

(AVI, QuickTime not supported in 2K modes). 
• Single link 4:2:2 I/O. 
• Real-time hardware color space conversion. 
• Hardware overlay for internal keying. 
• Surround Sound 7.1/5.1audio monitoring. 
• 8 channels of S/P DIF audio I/O. 
• Real time hardware Broadcast quality up/down/cross conversion 10 bit YUV 4:2:2 preview. 
• Look Up Table (LUT) support. 
• Aspect  ratio correction & 3:2 pull down support. 
• Genlock. 
• Symmetry software included. 
• 3 year warranty. 
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4.4 Feature Comparison 

 2K|Lust HD|Fury 2K|IridiumXP 
Video Modes    
2K HSDL: 2048x1556psF 14.99/15  Y  Y 
2K: 2048x1080 p/psF 23.98/24  Y Y Y 
HD 1920x1080 @ 60i, 59.94i, 50i, 24psF, 24p, 23.98psF, 
23.98p 

Y Y Y 

HD 1280x720 @ 59.94p, 50p, 60p  Y Y Y 
HSDL: 2048x1556psF 14.99/15  Y Y Y 
PAL 720 x 576  (4:3 and 16:9) Y Y Y 
NTSC 720 x 486 (4:3 and 16:9) Y Y Y 
Signal Formats    
10 bit SDI  Y Y Y 
Single link 4:2:2 (YUV) input  Y Y  
Dual link 4:4:4, 4:4:4:4 (RGB) input  Y   
Dual link, Video and Key 4:2:2:4 (YUV) input  Y   
Single link 4:2:2 (YUV) output  Y Y Y 
Dual link 4:4:4, 4:4:4:4 (RGB) output  Y  Y 
Dual link, Video and Key 4:2:2:4 (YUV) output  Y  Y 
2nd HD/SD SDI (YUV) output  Y Y Y 
3rd HD/SD SDI (YUV) output Y  Y 
Digital Audio I/O Signal Format    
8 Channels of AES-3id (Unbalanced, BNC) Y Y  

File Formats.    
10/8 bit RGB/YUV pixel format      
DPX, Cineon,  Y Y Y 
QuickTime V210 (not supported in 2K video modes) Y Y Y 
Hard ware Features    

Programmable color space converter  Y   

3 x 1D dedicated LUTS for viewing LOG images as Linear and 
for color calibration on an HD/SD broadcast monitor 

Y Y Y 

VANC support for time code and key code within SDI signal Y Y Y 
Internal hardware overlay (Internal Keyer)  Y Y  

RS 422 Ports Internal/External  Y Y Y 
LTC I/O  Y Y Y 
Genlock input  Y Y Y 
Safe area, safe title, letter/pillar/border generator Y Y Y 

 
 2K|Lust HD|Fury 2K|IridiumXP 
Independent Monitoring Features    

Real-time 2K/HD/SD up/down/cross conversion  Y Y Y 
Real-time resolution scaling, cropping, windowing  Y Y Y 
Aspect ratio correction and 3:2 pull down to HD SDI or SD 
SDI, including widescreen 

Y Y Y 

    
Onboard Memory.    
Memory 256MB 256MB 256MB 
    
PCI Interface    
PCI 64 bit 66 MHz   Y Y Y 
Compatible with all PCI and PCI-X 64 bit Slots. Y Y Y 
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5 Video Processing 

5.1 Conversion Matrix 

2K|Lust, 2K|Iridium XP and the HD|Fury can perform a range of conversion outputs via the dedicated SDI output X. 
 
The following table provides a list of possible conversion outputs bases on the mode, resolution and frame rate provided 
by the  Bluefush444 video card and the support SDIX converted output modes. 

 
Video Mode Frame Rate Converted output 
NTSC 29.97 NTSC 

1280 x 720P 59.94 Anamorphic, Pillar Box 
1920 x 1080i 59.94 Anamorphic, Pillar Box 

PAL 25 PAL 
1280 x 720P 50 Anamorphic, Pillar Box 
1080i 50 Anamorphic, Pillar Box 

1280 x 720P 59.94 NTSC Anamorphic 
NTSC Pillar Box 
1280 x 720P 59.94 
1920 x 1080I 59.94  

1280 x 720P 60 1280 x 720P 59.94 
1920 x 1080i 59.94 

1280 x 720P 50 PAL Anamorphic 
PAL Pillar Box 
1280 x 720P 50 
1920 x 1080I 50 

1920 x 1080Psf 23.97 NTSC Anamorphic 
NTSC Letter Box 
1280 x 720P 59.94 
1920 x 1080Psf 23.97 
1920 x 1080I 59.94 
1280 x 720P 59.94 Anamorphic, Pillar Box 
2K x 1080Psf Anamorphic 

1920 x 1080Psf 24 1280 x 720P 60 
1920 x 1080Psf 24 
2K x 1080Psf 24 Anamorphic 

1920 x 1080Psf 23.97 NTSC Anamorphic 
NTSC Letter Box 
1920 x 1080P 23.97 
1920 x 1080Psf 23.97 

1920 x 1080P 24 1920 x 1080P 24 
1920 x 1080Psf 24 

1920 x 1080I 50 PAL Anamorphic, Letter Box 
1920 x 1080I 50 
1280 x 720P 50  

1920 x 1080I 59.94 NTSC Anamorphic, Letter Box 
1280 x 720P 59.94 Anamorphic, Pillar Box 
1920 x 1080I 59.94 Anamorphic, Pillar Box 

1920 x 1080I 60 1920 x 1080I 60 
1280 x 720P 60 

1920 x 1080P 25 1920 x 1080I 50 
1920 x 1080P 25 

1920 x 1080P 29.97 No conversion 
1920 x 1080P 30.00 No conversion 
HSDL 2K 1556  14.98 1280 x 720P 59.94 Anamorphic 

1920 x 1080i 59.94 Anamorphic 
HSDL 2K 1556 15 1280 x 720P 60 Anamorphic 

1920 x 1080i 60 Anamorphic 
2K x 1080Psf 23.97 NTSC 

1280 x 720P 59.94 Anamorphic 
1920 x 1080Psf 23.97 Anamorphic 
1920 x 1080I 59.94 Anamorphic 
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2K x 1080Psf 23.97 
2K x 1080Psf 24 1280 x 720P 60 Anamorphic 

1920 x 1080Psf 24 Anamorphic 
1920 x 1080I 60 Anamorphic 
2K x 1080Psf 24 

2K x 1080P 23.97 NTSC Anamorphic 
1920 x 1080Psf 23.97 Anamorphic 
1920 x 1080P 59.94 Anamorphic 

2K x 1080P 24 1920 x 1080Psf 24 Anamorphic 
1920 x 1080Psf 24 Anamorphic 

5.1.1 SDI X Video Preview Resolution Limitations. 

The Video processing hardware on the 2K/HD products is limited to a specific bandwidth and resolution of 2K 
by 1080. 
Although the 2K/HD can support 2K by 1556, the scalar can only window a resolutions of 2K 1080 for retail 
time playback. 
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5.2 Pixel Aspect Ratio Processing 

The Bluefish hardware can apply pixel aspect ratio processing to a range of desired video outputs such as Letter 
box or (Anaphoric) wide screen preview.  
Depending on your monitoring device capabilities, you can switch the output to 4:3 or 16:9.  

5.2.1 NTSC wide to HD 1920 x 1080 Up scaling  

5.2.2 NTSC to HD 720p Upscaling 

 
 
 
 
 

 

1920 x 1080i 59.94 Anamorphic,  
Frame AR = 1.777 (16:9) Pixel AR = 1.0

NTSC  
Frame AR = 1.333 (4:3) 

Pixel AR = 0.9 

720 

486 Aspect Ratio 
Conversion 
Anamorphic

SDI X 

486 

720 

NTSC  
Frame AR = 1.333 (4:3), Pixel AR = 0.9

SDI 
A/B

Scaling

486

720 

NTSC (Widescreen) 
Frame AR = 1.333 (4:3) 

Pixel AR = 1.2 

1080 

1920 x 1080i 59.94 Anamorphic,  
Frame AR = 1 777 (16:9) Pixel AR = 1 0

720 

486 

NTSC (Widescreen) 
Frame AR = 1 333 (4:3) Pixel AR = 1 2

Scaling
Aspect Ratio 
Conversion 
Anamorphic

SDI X 

SDI 
A/B

720 

1280 

1920 
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5.2.3 HD to NTSC Downscaling 

 
 
 
 
 
 
 
 
 
 
 
 

Aspect Ratio 
Conversion 
Anamorphic

SDI X 

SDI 
A/B

NTSC Anamorphic 
Frame AR = 1.333 (4:3), Pixel AR = 1.2 

HD 29.97 
Frame AR = 1.778 (16:6), Pixel AR = 1.0 

HD 29.97 
Frame AR = 1.778 (16:6), Pixel AR = 1.0 

1920 
720 

486 
1080 

Scaling

1920 

1080 
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5.3 Hardware Format Conversion 

The hardware Format Conversion 3:2 pull down is a simple as playing back a clip and selecting the desired output 
format via SDI X. 
 

5.3.1 HD 23.97 Psf to HD 59.94 Conversion 

5.3.2  HD 23.97 Psf to NTSC 29.97 Conversion 

Frame rate  
Conversion 

3:2 
Scaling SDI X 

SDI 
A/B

HD 23.97 psf 
Frame AR = 1 778 (16:9) Pixel AR = 1 0

1080 

1920 
720 

486 

NTSC Anamorphic 
Frame AR = 1.333 (4:3), Pixel AR = 1.2 

HD 23.97 psf 
Frame AR = 1.778 (16:9), Pixel AR = 1.0

1080 

1920 

HD 23.97 Psf 
Frame AR = 1.778 (16:9), Pixel AR = 1.0 

1080 

1920 

1080 

1920 

HD 59.94 
Frame AR = 1.777 (16:9), Pixel AR = 1.0

 
Frame rate  
Conversion 

Scaling SDI X 

HD 23.97 Psf 
Frame AR = 1.777 (16:6), Pixel AR = 1.0

1920 

SDI 
A/B
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5.4 Cropping, Scaling and Panning 

The 2K lust supports the ability to perform a range of post processing up to frames of 2K by 1556 resolution. 
The 2K|Lust now supports hardware cropping and scaling on preview via the SDI X output. 
This allows you to load a clip and crop a desired section. 
You can also apply a scale on the cropped region 
  
In the following example a Film resolution frame at 2K 1080 @ 23.97 fps will be cropped to a HD 1920 x 1080 
window  then applied a 3:2 pull down to convert the frame rate to 29.97  

 

 

2048 

1080 

2K frame at 23.97 Psf is DMA 
to the 2K lust via memory or 
via SDI 4:4:4 or HSDL 

A  crop window is selected for 
1920 1080 frame size. 

The windows is positioned to 
the desired region via the 
horizontal and centered. 

The final result output via the 
SDI X outputting to HD 1920 
1080 29.97 via hardware 3:2 
pulldown.

1920 

1080 
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6 Software 

6.1 Windows 

Bluefish444 supports a range of software solutions and applications supported with the Bluefish444 retail installer 
that is shipped with your product box or downloadable on the Bluefish444 web site in the downloads section. 
 
Symmetry is Bluefish444’s proprietary integrated DI acquisition, review and play out software for Windows and is 
included with all Bluefish444 video I/O cards and the free retail installer. 
 
Symmetry was designed as a Digital Intermediary or as a capture and playback solution for digital content creators, 
compositors and editors that work in either 10 bit RGB or 10 bit YUV color space. Its flexibility and intuitive interface 
means that it easily integrates into any video or film postproduction environment. 
 
Bluefish444 continually updates Symmetry’s feature set allowing customers to constantly upgrade to new features 
– at no charge. Symmetry is a FREE integrated software solution for the Bluefish444 I/O video card product range. 
 
The Bluefish444 retail installer ships with the following software features and application support;  
 
Note 
Bluefish444 provide free the Symmetry DI application. And plug ins for 3rd party application support. 
3rd party applications are not included. 

 

 
 

2K|Lust/Iridium XP Support 
 
Third party applications that traditionally supported the HD lust may not automatically support the 2K lust features. 
Please contact the Product manufacture for the 2K feature and SDK version supported. 
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6.2 Bluefish444 Symmetry  

 
 

Symmetry is Bluefish444’s proprietary integrated DI acquisition, review and playout software for Windows and is 
included with all Bluefish444 video I/O cards. 
Symmetry was designed as a Digital Intermediary or as a capture and playback solution for digital content creators,  
Its main goal is to take EDL’s and digitize to a range of resolutions as industry standard formats of the highest 
quality. Its simple and  intuitive interface means that it easily integrates into any video or film post production 
environment. 
Bluefish444 continually updates Symmetry’s feature set allowing customers to constantly upgrade to new features 
– at no charge. Symmetry is a FREE integrated software solution for the Bluefish444 I/O video card product range.  
 
 

6.2.1 Supported Video Modes 

• Film 2K X 1556 @ 24p/psf  ( Cropped at 2K X 1080 via SDI X ) 
• SDI A/B and X supports up to 2K 1080 @ 24 fps 
• Film 2K X 1556 HSDL  @ 14.99/15 fps   
• SD X supports up to 2K X 1080 cropped 
• Film 2K X 1080 4:4:4, 4:2:2  @ 24 p/psf  23.98 p/psf 
• HD 1920 X 1080i @ 60, 59.94, 50  
• HD 1920 X 1080p @ 30, 29.97, 25, 24, 23.97  
• HD 1920 X 1080psf  @ 24, 23.97  
• HD 1280 X720p @ 59.94, 50  
• PAL & NTSC 4:3 and Widescreen 
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6.2.2 File Formats 

Video 

• 10 bit RGB Cineon Sequential file format LIN/LOG 
• 10 bit RGB DPX Sequential file format LIN/LOG 
• 10 bit YUV QuickTime v210  
• 8 bit RGBA TARGA  
• 8 bit YUV AVI 

Audio 

• Uncompressed wav 16 bit 48kHz PCM format.  

Features 

• Play list and clip assembly for preview and exporting to tape.  
• Trim clip mode.  
• Right Click Context menus.  
• Keyboard short cuts.  
• Offline file and Missing media import or capture.  
• Save and load projects in XML format for versatile 3rd party application support and project archiving.  
• channels of capture and playback, (or more depending on hardware).  
• Audio and Video linking and unlink ability to create Sym files.  
• Audio level monitoring.  
• Frame accurate RS 422 deck control.  
• Drop frame and non drop frame time code support.  
• Drop frame error reporting on capture and playback reporting.  
• Built in system bench marking and logging.  
• SMPTE and CGR scaling for 10 bit RGB file formats.  
• Force scaling option for APPLE SHAKE Rendered files.  
• Capture clip and master clip.  
• Assemble and Insert to tape.  
• Single frame grab to supported file formats.  
• Batch capture and capture clip.  
• Deck control interface with shuttle, jog frame advance and reverse.  
• Desktop preview in playback and capture.  
• 4:3 and 16:9 preview for SD widescreen footage.  
• Single and dual link support.  
• Loop playback.  
• Go o deck time code.  
• Status Bar.  
• Import export and batch lists generated from AVID DS Nitris.  
• Optimize capture option for fragmentation reduction on disk arrays. 
• 1D LUT conversion and Preview 
• 1D LUT loading and Custom controls 
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6.2.3 Symmetry System Requirements 

The following system requirements are for the 2K/HD product range running Symmetry 

Uncompressed HD/2K 

For further information and an updated list of tested storage solutions go to the Bluefish444 website at; 
 
http://www.bluefish444.com/support/compatibility/hardware/storage.html 

 
 HD/2K 

CPU Intel Dual Xenon 2.4 Ghz,  
Intel Duo Core 2  
AMD Opteron 242+ 

Operating System Windows XP 32 bit SP2,  
QuickTime 7.01+ 
Direct X 9.0C 

RAM 2GB or more for compositing applications 

Chipset 7505/7525/5000X/5400/ or AMD 

Graphics PCI express 

System Drive SATA/PATA/SCSI 

Video Storage Controller Device SAS/SCSI-U320/ 

Video Storage Type SCSI to SCSI/SATA 
SAS,  
FC to SATA* 

 RAID 0 

6.2.4 Sequential File Format Support 

Certain solutions may vary in performance when digitizing and playback of Targa, DPX and Cineon files.  
Most storage solutions are certified with HD 4:4:4 but this is with clip formats such as QuickTime or AVI. 
Sequential file formats are far more intensive than clip formats due to the need for the Disk array to read and 
write files at a rapid rate. 
 
With Sequential files, fragmentation is a common side effect and most apparent cause of performance 
regardless of free space available. 
 
Please ensure your storage solution is certified to support sequential file HD and 2K resolutions. 
 
http://www.bluefish444.com/support/compatibility/hardware/ 

. 
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6.3 Bluefish444 Feature Application 

The Feature Application or “Feature App “is the Bluefish444 control interface that runs independently to the 
applications using the Video card. 
 
It provides access the lower level functions of the Bluefish444 hardware that are not directly controlled by 
supported 3rd party applications. 
 
The Feature App controls signal format mode switching, scaling, analog or digital I/O selection, audio channel 
signal selection, letter box and sync input to name a few. 
 
The feature app also monitors current input and output modes and monitors current pixel or memory format the 
Bluefish444 card is in. This is a great feature when you need to monitor a valid input signal. 
 
The Feature App, depending on the installed Bluefish444 hardware will have different feature and tabs made 
available.  
For example, the 2K lust will have a Video Processing Tab where the SD greed or cards supporting analog will 
have an analog tab. 
 
The feature app is covered in more detail later in this manual. 
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6.4 Adobe Production Studio/ Creative Suite 3 

Bluefish444 continues to support one of the world’s most popular editing packages. 
Bluefish4444 have develop plug ins for the following Software application supported in the 
Adobe Production Studio 
 

• Adobe Premiere Pro 2.0/Cs3 
• After Effects 7.0/CS3 
• Adobe Audition 2/CS3 
• Adobe Photo shop CS2/CS3 

 
 
 
 

6.5 Adobe Premiere Pro CS3/2.0 

 
(Application Software not included) 
 
SD and HD 10 bit YUV uncompressed editor with software preview rendering  
10 bit YUV uncompressed editing. 
 
Bluefish444 provides native 10 bit YUV capture and editing of QuickTime v210 pixel format. 
Depending on the system performance you can play back uncompressed and compressed clips 
and sequential file formats that are supported by Adobe Premiere Pro 2, and are previewed and 
broadcast monitored in real time. 
 
Supports playback of Adobe Premiere Pro 2.0/CS3 supported file formats such as AVI, DV, 
TGA, JPEG, TIFF, MPEG etc. 
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6.5.1 Bluefish444 & Adobe Premiere Pro Features 

SD/HD and real time effects preview. 
Support for preview of the native Adobe Premiere Pro 2.0 effects & transitions software engine. 
Note, performance of RT playback of effects will be dependent on how many layers are processed and the 
number of effects applied. When exporting all effects will be rendered to 10 bit  YUV V210 pixel format before 
exporting to tape. 

Multiple file format real time playback*. 

Uncompressed and compressed clip and sequential file formats that are imported into the Adobe Premiere 
Pro 2.0 timeline are previewed and monitored in real time via SDI. 

SD DV offline. 
Within Adobe Premiere Pro 2.0/CS3 you can capture to SD DV AVI file format via SD SDI. 
SD DV AVI file format is 1/10th the size of SD 10 bit YUV uncompressed files, reducing storage capacity  
Using SD DV is a great feature for offline editing and generating an edit decision list for SD and HD 
uncompressed offline editing.  
SD DV offline AVI is an industry standard file format, providing DV editors with a migration option to 
uncompressed SDI I/O. 

Hardware Conversion 
2K Lust and HD Fury now support the added ability to upscale from SD resolutions to HD even 2K  
Edit in NTSC and PAL and experience broadcast quality HD 1920 1080 and 1280 720 real time output on the 
SDI X monitor output. 
Capture HD 1920 1080 23.97 and preview to to HD 1920 1080 29.97 or NTSC 29.97 simultaneously and in 
real time 
 
* Performance may vary on different Systems, controllers and RAID configurations. 

6.5.2 System Requirements 

CPU Intel Dual Xenon 2.4 Ghz, AMD Opteron 242+ 

Operating System Windows XP SP2, QuickTime 7.1.5 or greater, Direct X 9.0C 

RAM 2GB 

Chipset 5400/X38/7505/7525 or AMD Chipset 

Graphics AGP /PCI express 

System Drive SATA/PATA 

Controller Device SCSI/FC/SATA/SAS 

Video Storage External SCSI to SCSI/SATA, FC to SATA 

For a list of certified systems and storage solutions go to the Bluefish444 website at 
http://www.bluefish444.com/support/compatibility/hardware/ 
 

6.5.3 Real Time Playback in Adobe Premiere Pro 2.0 

Bluefish444 has introduced software real-time preview for effects and multi file format playback within the 
Adobe Premiere Pro editing solution.  Performance of RT Effects playback in Adobe Premiere Pro is scalable 
and increases as the system performance increases. The amount of data streams is based on the 
performance of the Premiere Pro playback engine, system CPU and the disk storage ability to access multiple 
streams of video and audio clips simultaneously to sustain real-time playback. 

 
Factors slowing the performance of RT; 
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Not using Bluefish444 v210 QuickTime files 
Compressed files that is traditionally complex to decode and taxes the CPU 
Multiple sequential files that are on a heavily fragmented disk array 
Using an unsupported storage solution or configuration 
Too many streams called for playback  
The type of effect used 

 
Bluefish444 uses the QuickTime 10 bit YUV v210 pixel format in our Adobe Premiere Pro editing mode. 

6.6 Adobe After Effects 7.0/CS3 

(Application Software not included) 
 
Animate your ideas. Adobe® After Effects® 7.0 software helps you create compelling motion 
graphics and blockbuster visual effects with efficiency, precision, and infinite variety. Take 
advantage of unmatched integration with other Adobe software, flexible 2D and 3D compositing, 
and hundreds of effects and Animation Presets to bring a new dimension to your film, video, 
DVD, and Macromedia® Flash® productions. 
 

• 2K, HD and SD Broadcast real time monitoring  
• Real-time playback via RAM player  
• and 10 bit RGB frame buffer support 
• and 10 bit project mode support 
• Dedicated QuickTime v210 exporter 
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6.7 Photoshop CS/CS2 

(Application Software not included) 
 
Adobe® Photoshop® CS2 software, the professional image-editing standard and leader of the 
Photoshop digital imaging line, delivers more of what you crave. Groundbreaking creative tools 
help you achieve extraordinary results. Unprecedented adaptability lets you custom-fit 
Photoshop to the way you work. And with more efficient editing, processing, and file handling, 
there's no slowing you down. 
 
HD and SD broadcast monitoring  
Action driven output, fully customizable via actions interface 
 

6.8 Sound booth 

(Application Software not included) 
 
Record, mix, edit, and master digital audio files with powerful tools that bring flexibility and control 
to your desktop studio. Easily create music, produce radio spots, and restore imperfect 
recordings. Bring audio and video together using smart integration with Adobe video applications. 
Get professional results in real time with Adobe® Sound booth software. 
 
Monitoring of uncompressed audio channels equal to the Audio selected output. 
Support 48000Khz monitoring 
channels of AES/EBU (Balanced, XLR) or 
Channels of AES-3id (Unbalanced, BNC) or 
2 channels 0dBu (Balanced, XLR) or 
2 channels -10dBu (Unbalanced, RCA) 
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6.9 Combustion 4 

(Application Software not included) 
 
Bring your imagination to life and get your work done faster with the easy-to-use 
Combustion® interface, its efficient workflow, and extensive toolset. Autodesk® 
Combustion® 4 software is an all-in-one professional compositing application designed to 
meet the needs of the world’s most demanding artists. 
 
SD and HD Broadcast real time monitoring  
Real-time playback via RAM player  
bit frame buffer support 
 
 

6.10 Fusion 5.X 

(Application Software not included) 
 
Fusion® 5 is a full-featured, node-based compositing system with built-in backend tools via a 
powerful scripting engine with ODBC support. A perfect balance between a backroom power tool 
and a front room client station, Fusion 5 has it all. Not only does Fusion 5 have a real 3D 
environment with camera/lights support for leading 3D packages, it is also one of the most 
powerful and intuitive 3D particle systems on the market. With hardware-accelerated 3D 
capabilities, you can now migrate from pre-vis to finals within the same application. Eyeon's Fusion 
is a true synergy of 2D and 3D tools for ultimate compositing. 
 

 
Integration of Bluefish444 into Fusion is developed by Eyeon using Bluefish444's SDK, Fusion artists have 
incredible performance and efficiency of system resources providing very fast and quick responses to changes to 
your flow and previews. 
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Fusion supports both 8 and 10bit frame buffer modes providing an incredible output through the Bluefish444 
hardware.  
Fusion allows artists the flexibility to monitor any node in any flow by a simple press of a key. 
 
Fusion also has the ability to generate a preview of you flow and play it a rendered flow branch in real time. Taking 
advantage of your frame store/storage system and not restricting you to the amount of RAM available on your 
system. 
 
Fusion can also take advantage of Symmetry, Bluefish444's deck control capture and play out software, free with 
all Bluefish444 products. 
 
Artists can also render to these file formats and play out with symmetry for preview and export providing an 
effective, high quality RGB/YUV workflow preserving crucial file header and scaling information and eliminates 
costly file conversions and the risk of image degradation. 
 
www.eyeonline.com 
 
SD and HD Broadcast real time monitoring  
Real-time playback via Preview 
and 10 bit frame buffer support 
 
Versions Supported 5.1, 5.2, 5.3, 32 bit Support only. 
64 bit support of fusion coming soon. 

6.11 Supported 3rd Party Retail Applications 

The 2K|Lust , HD|Fury and 2K|Iridium XP  products supports a range of retail and OEM solutions that are readily 
available from various resellers or directly from the manufacture. SD| Greed provides professional editors, 
compositors and artists with a choice of solutions on various platforms. The support is continually growing. 
 
The following applications require a particular driver/SDK version. Please refer to the manufactures website or the 
blueffish444 website for driver compatibility support for you applications 
 
For example, the current retail installer 5.2.115 supports an SDK/Driver version 5.2.6.11. 
You will need to ensure your 3rd party application supports that Driver. 
 
For further information; 
 
http://www.bluefish444.com/support/compatibility/software/ 
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7 What’s in the Box 
 
 
 

2K|Lust 2K|Iridium XP HD|Fury 

 
 
 

 

 

 
Digital Audio S/P DIF I/O 
 
 

1 x HD 15 pin with 8 BNC consisting of 4 pairs  
Labeled ‘DIG AUDIO IN’, DIG AUDIO OUT’, ‘1/2’, ‘3/4’, ‘5/6’, ‘7/8’. 

 

Deck Control 
 
 
 

Mini Din 8 pin RS 422 to 232 deck control cable for 2K|Lust RS 232 
ports. 
Symmetry and Premiere Pro do not support the Deck control port on the 
2K|Lust RS 232 ports  You must use the COM port and the RS 422 to 
RS 232 cable provided 
 

 
 

DB 9 pin, RS 422to RS 232 Serial VTR cable 
 
Supports Symmetry and Premiere Pro Serial VTR controller. 
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8 System Requirements 

8.1 Hardware 

Below are the system requirements the 2K/HD product range. 
Please note the requirements are general and performance may be different for each motherboard. 
For a certified list of motherboards and recommendation, please refer to the hardware certification guide at  
http://www.bluefish444.com/support/compatibility/hardware/ 
 
Note not all motherboards that support PCI X or PCI 64 bit Slots may have adequate bandwidth. 
It is recommended to use certified and tested hardware from Bluefish444 

 
  

Card 2K|Lust HD|Fury 2K|IridiumXP 
  

 

 

Slot Type 64 bit / 66 MHz PCI Card. 
Slot requirements PCI/PCI X 64 bit slot motherboard 

NOTE; Installation should be on a separate PCI bus to that of the Storage Host controller. 
Chipset 5400/X38/7505/7525, AMD 200 + 

Bluefish444 does not support motherboards with the PCI X tunnel chipsets From NEC 
 

System HP XW9300, HP XW 8200, HP XW 8400 ( Dual Core), BOXX APEX,  
Dell T5400 
For a list of certified systems please go to 
http://www.bluefish444.com/support/compatibility/hardware/systems.asp 

Memory 2GB minimum ( Application dependant) 
Direct X Direct X 9C 
QuickTime 7.4.5 or above 
OS Windows XP SP2, server 2003 

Windows XP 64 (Supported for certified applications. Symmetry and Aspex hardware option  
CPU 
 

• Uncompressed  I/O     
o 3.0 GHz single core Or 2.0 GHz dual core and above 
  

8.1.1 Slot Configuration 

For the Bluefish4444 2K/HD product rage the most import feature you must be aware of the motherboard BUS 
configuration and what slots are shared with the same Clock speed and what slot you install you Bluefish444 
card into. 
 
In PCI architecture where slots share the same buss, each slot will be as fast as the slowest device installed. 
If you install a Bluefish44 HD card and a PCI X controller card the on the same BUS, all devices will be equal 
to the maximum speed of the SLOWEST card. Therefore, the PCI-X 133 card will perform at 66 MHZ equal to 
the HD card clock speed. 
 
For PCI e slots this does not occur. 
For PCI 64 bit slot cards the Clock speed of the PCI bus varies with each slot type; 

 
Installed Slot Buss Speed 
32 bit slot Not Supported by Symmetry and supported retail applications 
64 bit slot 66 MHz 
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8.1.2 Slot Installation 

In most cases, you will be using a SCSI or Fiber channel Host controller card supporting a PCI X 133 slot. 
Care must be taken when installing the Bluefish4444 HD 64bit PCI card with such devices. 
It is a requirement that the Host controller card is to be installed on a BUSS not shared with the Bluefish444 
PCI 64 card or it will affect performance of any devices shared in the PCI X 133 controller card. 
 
Refer to your motherboard/system manual or IT hardware specialist regarding the buss configuration and what 
slots are is shared 

8.1.3 ZCR Slots 

In some motherboards, the Zero Channel RAID slot is available 
It is not recommend installing the Bluefish444 card in this Slot due to varying and inconsistent performance 
issues 
Below are some common Slot /Device installation examples. 

8.1.4 Shared Buss Configuration Example 

The following example shows two possible configurations with a PCI X and PCI e host controller  
 

 
 

 

PCI Exp 16 

PCI Exp 4 

Shared Bus

PCI Exp Host Controller

PCI-X 133 MHz 

PCI-X 100 MHz 

PCI-X 133 MHz 

PCI 32 MHZ 

PCI-Exp HOST CONTROLLER 

PCI e GPU
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PCI-X HOST CONTROLLER 

PCI-X 100 MHz 

PCI-X 133 MHz 

PCI-X 133 MHz 

PCI 32 MHZ 

Shared Bus

PCI X Host Controller

PCI Exp 4 

PCI Exp 4

PCI Exp 16 
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8.2 Storage Requirements 

The 2K and HD  product range is primarily an uncompressed capture and playback solution support sequential 
file format digitizing and playback, providing an unprecedented level of quality on the Windows, Linux and 
Apple Mac OS systems.  
For a list of certified and tested storage solutions please refer to the Bluefish444 Tested hardware Guide at; 
http://www.bluefish444.com/support/compatibility/hardware/ 

8.2.1 Onboard SATA Controllers. 

Modern motherboards come with more than one SATA controller that can apply hardware RAID across 
multiple SATA drives.  
We do not recommend using SATA based controller device for any form of HD sequential file digitizing or 
playback unless the device is a Bluefish44 certified solution. 

8.2.2 Onboard SAS Controllers. 

Modern motherboards come with 8 port  SAS controller that can apply hardware RAID across multiple SAS 
drives.  
Bluefish444 at the time of this 

8.2.3 Storage Capacity Guide 

W x H x Pixel Byte Size x 
Frame rate/1024² = MB/sec 

RGB(10) 
(40/10)  
MB/sec 
(frame size) 

RGBA(8)  
(40/10) 
MB/sec 
(frame size) 

RGB (8)  
(40/13) 
MB/sec 
(frame size) 

V210 
(40/15) 
MB/sec 
(frame size) 

BV10 
(40/16) 
MB/sec 
(frame size) 

      
High Definition  
      
1280 X 720P @ 60/1.001  210.72 (3.51) 210.72 (3.51) 162.09 (2.7) 149.16 (2.34) 139.83 (1.59) 
1280 X 720P @ 60  210.93 (3.51) 210.93 (3.51) 167.97 (2.7) 149.30 (2.34) 139.97 (1.59) 
       
1920 X 1080 @ 24/1.001  189.84 (7.9) 189.84 (7.9) 149.16 (6.08) 132.58 (5.27) 124.30 (4.94) 
1920 X 1080 @ 24 189.84 (7.9) 189.84 (7.9) 149.16 (6.08) 132.58 (5.27) 124.30 (4.94) 
1920 X 1080 @ 50 (25) 197.75 (7.9) 197.75 (7.9) 155.52 (6.08) 138.24 (5.27) 129.60 (4.94) 
1920 X 1080 @ 60/1.001 (30)  237.30 (7.9) 237.30 (7.9) 186.44 (6.08) 165.73 (5.27) 155.37 (4.94) 
1920 X 1080 @ 60  (30) 248.83 (7.9) 248.83 (7.9) 186.63 (6.08) 165.89 (5.27) 155.52 (4.94) 
1920 X 1080 @ 25  207.36 (7.9) 207.36 (7.9) 155.52 (6.08) 138.24 (5.27) 129.60 (4.94) 
1920 X 1080 @ 30/1.001  248.58 (7.9) 248.58 (7.9) 186.44 (6.08) 165.73 (5.27) 155.37 (4.94) 
1920 X 1080 @ 30 248.83 (7.9) 248.83 (7.9) 186.63 (6.08) 165.89 (5.27) 155.52 (4.94) 
      
2048 X 1080P @ 24P  202.5 (8.43) 202.5 (8.43) 155.7 (6.49) 135.0 (5.62) 134.8 (5.27) 
2048 X 1556 @ 24P  291.7 (12.15) 291.7 (12.15) 194.5 (9.35) 194.4 (8.10) 182.16 (7.59) 
HSDL 218.8 (12.15) 218.8 (12.15) 145.8 (9.35) 145.8 (8.10) 136.62 (7.59) 
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9 Cable Connection  

9.1 HD|Lust 

SDI Video I/O 

Digital Audio I/O 

Ancillary Interfaces 

LTC Out

RS 422 port C

LTC In

RS 422 port D

SDI 4:2:2 / 4:4:4 / Video  
Preview & Conversion Output 

Output Link

Output Link

Input Link A

Input Link B

Genlock

Output Link 

SDI 4:2:2 / 4:4:4 / Video

SDI 4:2:2 / 4:4:4 / Key / 
Video

SDI 4:4:4 /

SDI 4:2:2 / 4:4:4 / Video / 
Key 

AES/EBU/SPDIF Output Ch

AES/EBU/SPDIF Output Ch

AES/EBU/SPDIF Output Ch

AES/EBU/SPDIF Output Ch

AES/EBU/SPDIF Input Ch 1&2

AES/EBU/SPDIF Input Ch 3&4

AES/EBU/SPDIF Input Ch 5&6

AES/EBU/SPDIF Input Ch 7&8

Note;  
• For Single 4:2:2 input the SDI cable must be placed on the Input link B. 
• For Dual link 4:4:4 input/output you require two cables in both link A and Link B ports.  
• The 2K lust SDI inputs for 4:4:4 modes need to be switched Link A from deck to Link B Lust, Link B from 

deck to link A from Lust 
• For Dual link 4:4:4:4 Video and Key, Video is Link A, Key is Link B. 
• For internal keyer, the input must be on link B. 
• On board LTC and RS 422 ports are not used with certain applications such as Adobe Premiere Pro unless 

stated 
• 2K|Lust does not support SDI Audio 
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9.2 HD|Fury 

SDI Video I/O 

Digital Audio I/O 

Ancillary Interfaces 

AES/EBU/SPDIF Output Ch 
1&2
AES/EBU/SPDIF Output Ch

AES/EBU/SPDIF Output Ch

AES/EBU/SPDIF Output Ch

AES/EBU/SPDIF Input Ch 1&2

AES/EBU/SPDIF Input Ch 3&4

AES/EBU/SPDIF Input Ch 5&6

AES/EBU/SPDIF Input Ch 7&8

Genlock Input

Output Link SDI 4:2:2 / 4:4:4 / Video

Input Link SDI 4:4:4 / Video

Output Link SDI 4:2:2 / 4:4:4 / Video  
Format converter (HD or SD)
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9.3 2K|Iridium XP 

SDI Video I/O 

Output Link A   

Output Link B   

Genlock Input 

Output Link X  SDI 4:2:2 / 4:4:4 / Video  
Format converter (HD or SD) 

SDI 4:2:2 / 4:4:4 / Video  

SDI 4:2:2 / 4:4:4 / Key / Video 
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10 Installation 
 

10.1 System Requirements. 

Uncompressed 2K, HD and SD. 

For a list of certified systems and configurations, please go to the following link 
http://www.bluefish444.com/support/compatibility/hardware/ 

 
Operating System Windows XP sp2 with Updates 
QuickTime QuickTime 7.4.5 and above 
Directx  DirectX 9c 
Editing/Production 
Software Suite  

Adobe Premiere Pro 2.0 /CS3  
After Effects 7.0.2/CS3 
Adobe Photoshop CS2 CS3 
Other Supported 3rd party software 

System HP XW 8200, 8400, 9300, 
Dell T5400  
Intel or AMD Motherboard based system, 
2 GB RAM or more for compositing application 
 
See hardware guide for the latest tested and certified hardware at; 
http://www.bluefish444.com/support/compatibility/hardware/  
 

Graphics DirectX 9 hardware capable card with 128 MB RAM of more  
ATI catalyst version 7.2 
ATI Fire GL version 8.323.1 
NVIDIA version QuadroFX  & Geforce 91.36 

Disk Storage  Please refer to the certified Storage solutions section on the Bluefish444 website 
at; 
 
http://www.bluefish444.com/support/compatibility/hardware/storage.html 

 
* Note; Performance of systems may vary with different computer system components, storage 
configurations and work environments, Results and requirements found in this guide will be subject to 
change without notice. 
 
NOTE; 
It’s recommended to use tested and certified hardware solutions and components. In most cases, we 
cannot provide any support for non-certified solutions.  
Bluefish444 cannot guarantee the performance when using non-certified components and using such 
components are done so at your own risk. 
 
See hardware guide for the latest tested and certified hardware at; 
http://www.bluefish444.com/support/compatibility/hardware/ ) 
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10.2 Installation Steps 

• Prepare your system. 
• Install 3rd party applications. 
• Install QuickTime version 7.1.5 or above 

 
Installing the Bluefish444 hardware. 

 
• Card Installation 
• Connecting to the outside world  
• Driver Installation 
 
3rd Party Software Setup 
 
• Adobe Premiere Pro  
• After Effects 
• Audition 
• Combustion  

10.3 Prepare your system. 

Ensure you have installed the latest OS versions, driver and BIOS updates for your system. 
Please refer to the certified hardware guide section or the readme document for more information. 
http://www.bluefish444.com/support/compatibility/hardware/ 

10.3.1  Install 3rd party applications. 

It’s recommended to pre install supported applications before running the Bluefish444 installer.  
If you install 3rd party applications after running the Bluefish444 installer. You will be required to re install. 
This will install plug ins and presets for the 3rd party applications  

10.3.2  Install QuickTime version 7.4.5 or above 

Download and install the latest QuickTime installer available at the following site.  
http://www.apple.com/quicktime/ 

10.4 Installing the Bluefish444 Hardware 

Bluefish444 provides detailed information on tested and certified hardware configurations for a range of common 
motherboards and computer systems. 
 
Please refer to this free informative section available on our web site at the following 
Link; http://www.bluefish444.com/support/compatibility/hardware/ 
 
SD| Greed PCI 32 bit card is used in this example 
 
Place your system in an easily accessible place that has sufficient lighting. It is not recommend to insert the card in 
an awkward position that will increase the chances of a poorly contacted or incorrectly inserted card. 
Ensure your hands are clean and free of dirt and fluid. 
Remove your systems protective case. 
Make sure you are earthed and discharge any static build up before handling the Bluefish444. With your hand, 
touch the metal frame of the PC case to discharge any static electricity you may have built up. 
Remove the power cable from your system. 
Identify a free PCI slot as outlined in the hardware configuration for your Bluefish444 certified motherboard or 
system. 
Remove the PCI slot aperture for the corresponding slot the SD| Greed card will be inserted into. 
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For more detailed information on correct slots for your motherboard or system type, please refer to the Bluefish 
systems and hardware support section at;  
 
http://www.bluefish444.com/support/compatibility/hardware/ 
 
For systems with an onboard SCSI controller such as the HP 8200/9300, the 100 MHz bus is shared with the 
onboard SCSI, so it is wise to place the SD| Greed in the PCI - X 133 MHz slot ( Slot 4 on the G5), so as to not 
affect the performance of the SCSI or FC controller card.  

10.4.1 Card Installation 

Remove the Bluefish card from the 
antistatic bag. 
Hold the card by the PCI shield top and at 
the top of the PCB at the opposite end of 
the PCI shield. This will reduce any 
chance of any damage of the bluefish444 
card circuitry. 
Do not touch the components on the 
PCB, do not touch the PCI slot mating 
edge. 
(See handling region diagram below). 
 
Insert the card into the correctly chosen 
slot by firmly pressing down on the metal 
PCI shield and the edge of the PCB. 
Secure the card with a screw or PCI clip, 
depending on the chassis and computer 
system you are using. 
Replace the system chassis cover and connect the power to your system. 

Areas to apply force 
On edge of PCB and 
PCI shield 
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10.5 Connecting to the outside world 

The Bluefish 2K/HD  product range are an extremely versatile Video/Audio I/O card that can connect to a range of 
devices simultaneously.  There will be a range of connection workflows that can not be covered by this manual 
instead we will focus on two typical connection work flows commonly used in the professional broadcast industry. 
 
Taking advantage of video cards with Analog video and audio I/O, provides a powerful analog to digital converter in 
one PCI card, this removes the need of expensive external devices for video and/or audio conversion. 
 
 
 
 

 

  

Dual Link 4:4:4  
SD I/O 

Beta cam SP

SDI/Analog  
Monitors 

Consumer recorders & 
playback devices,   

VCR/DVD 

Consumer  
Television 

Digital 5.1 Surround Sound 

Digital 7.1 Surround Sound 

DVI / HDMI 
Monitors 

SDI to DVI 
Converter
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10.5.1 2K HSDL HD 4:4:4 I/O 

The guide is for the 2K Lust for all 4:4:4 I/O connections. Note that SDI A source needs to be linked to SDI B  
or the BF card for input. 
 

 

10.5.2 HD 4:4:4 to 4:2:2 Conversion 

The following example is a typical workflow when digitizing from a dual link source for 10 bit RGB I/O and 
monitoring the process in YUV color space on an HD monitor or HD YUV deck.  
 
 

 
 

SDI A 

Dual Link 4:4:4 Deck 
10 bit LOG 

SDI B 

SDI A 

SDI B 

2K|Lust Card 

SDI A 

Dual Link 4:4:4 Deck 
10 bit LOG 

SDI B 

SDI A 

SDI B 

SDI X 

2K|Lust Card 

HD Monitor HD YUV Deck 

10 bit YUV ( linear) 

Log to  
Linear  
1D Lut 

conversion
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10.5.3 HD 4:2:2 to SD conversion 

The following example is a typical workflow when digitizing from a HD YUV deck for  I/O and monitoring the 
process in YUV color space on an SD monitor or mastering the deck .  
 

 
 

SDI X 

2K|Lust Card 

HD YUV Deck 

SDI A SDI B 

SD YUV Monitor 

SD YUV Deck 
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11 Driver Installation 
The HD Product range is a multiplatform video card supporting the Windows and Linux operating systems. This manual will 
cover the installation procedures for the Windows operating system only.  

11.1.1  Linux Support 

Linux drivers and SDK is available for registered OEM developers. Please register as an OEM developer on 
the bluefish444 website. 
 
http://www.bluefish444.com/support/oem/default.asp 

11.1.2  SDK Installation 

Bluefish provides a software developers kit for the Windows and Linux platforms. Information on obtaining the 
SDK is available online at the Bluefish website at; 
 
http://www.bluefish444.com/support/OEM./. 
 
Linux support and drivers is via OEM solutions only and is available via application. 
 
Do not use the SDK installer for retail installations or for public distribution. You must use the Bluefish retail 
installer. 
 
If your solution provider recommends using the Bluefish444 retail installer ensure that you know what the SDK 
driver version the supported application was developed with . 
 
In each bluefish444 retail installer we list the SDK\Driver version, this needs to match. 
In some circumstances if an older SDK version was used the new retail driver SDK version is backwards 
compatible. This is not guaranteed. 

11.1.3  Windows Installation 

Key points to remember when to run the Bluefish444 installer; 
 

• You must have Administrator privileges.  
• You must install the Bluefish444 installer for each user of the same workstation.  
• Always uninstall any previous installer before running the installation program. 
• Always shut down your system, after installing the drivers, do not do a soft restart. 
• Always run the installer if you change cards, even if it is the same model, as there maybe different 

firmware versions that are not compatible with the installer version you intend to use. 
• Always read the latest release notes  
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11.2 New Installations 

The following steps are for new installations of your Bluefish444  

1. With the Bluefish44card installed, turn on your system. 

2. When Windows loads, you may be presented with “New 
Hardware Found“ Dialog box. 

3. Close the Dialog box. 

4. Run the Bluefish444 installer vXXX. 

5. Select next and say yes to the license agreement to 
continue. 

Ensure you read the license agreement before agreeing to it. If 
you do not agree to the license agreement installation will not 
continue. 

6. During installation a Hardware Installation window will pop 
up, this is sometimes behind opened windows. 

7. Select Continue Anyway. 

8. Restart your system. 

You may under certain circumstances see another “new 
hardware found” dialog box appear after you restart your 
computer.  

9. If the “found new hardware Wizard” dialog box appears. 

10. Select “install the software automatically” option. 

11. Select next. 

12. Select “Continue Anyway. 

13. Select finish. 

14. Launch Symmetry or Bluefish444 feature application to 
test your configuration. 
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11.3 Manual Removal of Bluefish444 files and drivers 

11.3.1 Step 1 - Uninstall Bluefish4444 Installers. 

1. Make sure you have closed all applications. 

2. In the Windows Control panel, go to Add or Remove Programs. 

3. Select all Bluefish444 installers in the Add remove programs dialog box.  

If you have more than one Bluefish444 Installer installed, you will need to repeat this process. 

11.3.2 Step 2 - Remove Bluefish444 Drivers and System files. 

Note, you will be deleting files that are in system folders, ensure you do not delete incorrect files as this 
may affect the operation of your computer system. 
 
You will also need to turn on “show system files and folders” in Tools-> Folder Options -> View 

4. In “Windows Explorer”  select tolls and folder option in the menu bar 

5. Select the “View” tab 

6. In advance settings scroll to “Hidden files and folders” 

7. Select “Show hidden files and folders” 

8. Go to the C:\Windows\inf folder and open it 

9. Select the Search Utility and select the “Files or Folders” option. 

10. In the “What do you want to search for” option box select “A word or phrase in the file” 

11. Type in “Bluefish” 

12. A file name beginning with OEMX.inf will be presented, X donates a numeric value e.g. OEM11.inf. 

13. Delete the file. 

14. Type in and search for the following files and delete all instances of them. 

15. In C:\Program Files delete the Bluefish444 folder and all the contents, 

16. In C:\WINDOWS\system32 folder delete the following files; 

 

• BlueSetupApi.dll 
• BlueVelvet3.dll 
• BlueVelvet3_d.dll 
• BlueVelvet.dll 
• BlueVelvet_d.dll 
• BlueVelvetCom.dll 
• Puffer.dll 
• BXQTPremiere.dll 
• FileInterChangeDll3.dll 
• BFFileAdapters.dll 

 
 

Note not all these files may or may not be present due to uninstall process in step 1, 
 
In C:\Program Files\BlueFish444\Driver, delete the following files if present; 

• BlueDriver.sys 
• BlueSD.sys 
• BlueGM.sys 
• BlueHD.sys 
• BlueBAG_X.rbf files, X denotes a numeric value e.g. BlueBAG_147.rbf 
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11.3.3  Step 3 - Delete Plug-in’s. 

17. In the Start menu, select the Search Utility and select the “Files or Folders” option. 

18. In the “What do you want to search for” option box select “  All Files and Folders”. 

19. Type in and search for the following files and delete all instances of them. 

For After Effects 

• BlueFish444IO.aex 
• BlueFishEMP.aex 

For Adobe Premiere Pro 1.0/1.5 

• bluefish444asio.dll 
• cm-Bluefish-Compiler.prm 
• im-Bluefish-Import.prm 
• pm-Bluefish-Playback.prm 
• rm-Bluefish-Record.prm 

For Adobe Premiere Pro 2.0/CS3 

• BFComplie.dll 
• BFPlayback.dll 
• BFRecordDV.dll 
• BFRecord.dll 
• BFImport.dll 
• Bluefish444 Editing Mode.XML 

11.3.4  Step 4 - Uninstall Drivers via Device Manager. 

20.  Open Device Manager for the Windows operation system 

21. In “Sound, Video and Game Controllers” right click the “Bluefish444 “X” device” and select “Uninstall”. 
(X Denotes Bluefish444 product type) 

22. Follow onboard prompts. 

23. Restart your system. 

11.3.5  Step 5 - Installation. 

24. Turn on your system with the Bluefish444 video card installed in t he correct slot. 

25. When Windows loads, you may be presented with “New Hardware Found“ Dialog box. 

26. Close the Dialog box. 

27. Run the Bluefish444 installer v5.X.X 

28. Say yes to all prompts to continue.. 

29. Select yes to shut down the system if required. 

If your system does not shut down automatically; 

30. Go to “Start” menu button and select “Turn off Computer”. 

31. Select “Turn Off” to shut down your system. 

32. Restart your system 

You may under certain circumstances see another “new hardware found” dialog box appear after you 
restart your computer.  
 
If the “found new hardware Wizard” dialog box appears; 

33. Select “install the software automatically” option. 
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34. Select next. 

35. Select “Continue Anyway 

36. Select finish 

37. Launch Symmetry or Bluefish444 feature application to test your configuration. 
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12 Feature Application 

12.1 About the Bluefish444 Feature Application. 

The Bluefish444 feature application allows you to control and monitor your Bluefish444 Video I\O card. It can be 
used as a diagnostic tool and provides an interface to enable or disable extended features independently of your 
current software application. The Bluefish444 feature app provides at a glance a range of information about what 
video mode and pixel format your card is currently operating in. 

12.1.1 Video Processing 

With the latest release of the 2K|Lust and the HD Fury has introduced a range of new preview features via the 
SDI X SDI output. They include; 

 
• Scaling,  
• Up conversion,  
• Down conversion  
• Hardware 3:2 Pull down ( Preview SDI X) 
• Cropping  
• Panning 

 
Control of these features are performed via the Bluefish444 feature App. The following section will provide a 
description and  guide on the Video processing features of the SDI X output 
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12.2 Feature App Main Control Interface. 

The Bluefish444 feature application interface supports all of the Bluefish444 product range. Depending on the card 
type you have installed, the Bluefish444 feature app will make available certain features. For example the 
SD|Greed SDI/analog video I/O card supports both dual link SDI I/O as well as Analog I/O. When the feature 
application is launched you will be presented with two section tabs, the main feature app section, Audio and an 
extra Analog BNC property tab Bluefish444 Feature App section. 
 

 

12.2.1 Card information 

Card Type 

This tells you what card you have installed and is currently active for the Feature Application. 
 
If you have more than one Bluefish444 card installed the feature application will ask you which card you wish 
to attach to each time the Feature App is launched. 

Pixel Format. 
Indicates what pixel format, the card is set to. Pixel formats , also referred as the frame buffer mode, engine or 
memory format the hardware is currently operating in. Some of the pixel formats supported by the SD|Greed 
are; 

 
Pixel Format Color Space Link Bit Depth 
ARGB 
ARGB_PC 
BV8 
BV10 
CINEON/DPX 
V210 
2VUY 
YUVA 

BGR+A 
RGB+A 
YUV 
YUV 
RGB 
YUV 
YUV 
YUV 

4:4:4:4 
4:4:4:4 
4:2:2 
4:2:2 
4:4:4 
4:2:2 
4:2:2 
4:2:2 

8 bit 
8 bit 
8 bit 
10 bit 
10 bit 
10 bit 
8 bit 
8 bit 

 
Depending on the application used will determine what memory format the SD|Greed is currently in at the time 
the feature app was loaded. You can update the information by clicking refresh. Final Cut Pro and Adobe 
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Premiere PRO for example use the v210, a 10 bit YUV memory format,  some applications can also use 
multiple memory formats.  

Input Signal Type. 
Indicates the current signal the card is receiving on the SD Input source from the deck or other signal source. 

Output Video Mode. 

Indicates the current video mode the SD|Greed is in. The video mode can not be change in the feature 
application, it is controlled by the Application (e.g. Adobe Premiere Pro or Combustion, etc) 

12.2.2  Video Output Control 

This section gives you direct control of the output signal format from your Bluefish444 product. Altering these 
settings will override what the current application has set the card to. In most cases you will not need to use 
these features as the application will enable or disable them.  

Video + Video, Video + Key; 
Dual link cards allow you to switch the Link B BNC between KEY or VIDEO 

Video or Key; 

Allows you to switch the output of our single link cards between KEY and VIDEO KEY is the alpha channel 
output of a Video or Frame. The Bluefish444 dual link cards have the ability to extract the alpha channel and 
output to a specific BNC.  
Video and KEY is normally used in live broadcast environments such as virtual sets. 

12.2.3  Timing Adjust.  

Reference Video Mode; 

Displays the input type that Bluefish444 card is detecting on the reference input. 

Reference Video Source; 
This allows you to select the reference source as either   
 

• Genlock BNC 
• SDI link A 
• SDI link B 
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Horizontal; 
Adjusts the relative horizontal timing between the Genlock signal and the cards output signals 

Vertical; 

Adjusts the relative vertical timing between the Genlock signal and the cards output signals 

Set; 
Commits any changes made to the new default power up values 

12.2.4 Miscellaneous Functions. 

Safe Picture; 
Enable and disables the safe picture overlay on the SDI output. 

Safe Title; 
Enable and disables the safe title overlay on the SDI output. 

12.2.5 Enable Onboard Keyer; 

The onboard keyer feature provides you with the ability to apply graphics and animation content over the 
incoming stream and out put the result in real time.  
Perfect for real time overlay and logo branding for off the shelf applications. 
Applications that can be used are Adobe After Effects, Discreet Combustion, VDS Twister, Photoshop CS/7.0,  
Eyeon Digital Fusion, Symmetry 2.2 and many more that support the following frame buffer mode, 8ARGB or 
8BGRA 
 
Symmetry supports TARGA 32 bit sequences playback and capture and can effectively be used to playback 
clips that can be keyed with the Bluefish444 video cards supporting Internal Keyer.  
With the feature and Symmetry, you can load a range of sequences with the play list feature and output 
animations and frames over your incoming video.  

12.2.6 Letter Box. 

This section controls the letterbox feature that Bluefish444 hardware supports. Letterbox blanks the top and 
bottom of the screen. This is used to create a 16.94:3 monitor 

Letter box lines 
Controls the amount of horizontal blanking lines at the top and bottom of the screen. 

Set 
Commits the changes to the Bluefish444 card 
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Cropping presets 
Contains a range of cropping presets such as 16:9, 4:3, 2.35:1, and custom 
Custom - Activates the Advance Blanking control section 

12.3 Video Processing 

With the latest release of the 2K|Lust and the HD Fury has introduced a range of new preview features via the SDI 
X SDI output 
They include; 
 

• Scaling,  
• Up conversion,  
• Down conversion  
• Hardware 3:2 Pull down ( Preview SDI X) 
• Cropping  
• Panning 
 

Control of these features is performed via the Bluefish444 feature App. The following section will provide a 
description and guide on the Video processing features of the SDI X output 
 

 
 

12.3.1 Video Output Modes 

The Video Output Modes box provides a quick indication of the current Video modes SDI A and B and SDI X 
are currently set to. 
 

 
 
SD I A and B will output the main video mode set by the application. 
SDI X will then process this video mode via the hardware video processor. 
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The video processor for the SDI X output accepts the same frame as the SDI A and B outputs, but can only 
process a 2k x 1080 Preview window within this frame. 
For HSDL 2K x 1556 the video processor will only accept 2K x 1080 frames at HSDL frame rates. 

12.3.2  Main Output Window Position (SDI A, B and X) 

The Main output Windows position allows you to set the vertical position of the Preview window  
This option is available when video mode resolution is greater than the Video Processor Window video. 
This will only occur in 2K video modes 
 

 
Symmetry automatically detects the differences and automatically centers the Video Preview Window position 
to center 
 
The following example demonstrates when you wish to change the vertical position of the Video preview 
windows if it is not automatically centered by a supported application. 

Manual Control 

You can also use the Up and Down arrow controls for manual position  
 

12.3.3 SDI X 

The following section controls the SDI X preview output. 
The Video Processor is provides a Main preview window normally equal to the Video Mode for example 2K x 
1080 @ 24 fps 
The 2K  x 1080 frame is then sent to the Hardware Video Processor, where the Source Windows Size and a 
Scalar Profile is selected for the final SDI X preview output. 
 

Shifts the Main Output Window UP in one line increments
Centers the Main Video Window UP

Shifts the Main Output Window DOWN in one line increments

 
 

Video Output Window Size

Video mode 

  

Default vertical position with 
Window centered 

Vertical position changed to 
a desired value

Vertical position in units of lines = 238 Vertical position in units of lines = 0 

Main Output Window Position 
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From here you can; 
 

• Select a window size. 
• Scale the window size up ( up conversion). 
• Scale the window size Down (down conversion. 
• Select a pre defined Scalar profile. 
• Manually select the Source window of the scalar via Width and Height. 
• Manually change the Source window Preview. 

Window Size 
Window size determines the size of the window the scalar is to process. 
The drop down list is populated with a valid mode that supported by the Main video window given to the Video  
Processor. 

Source Window Width 
Sets the width of the source windows in pixels. 

Source Window Height 
Sets the height of the source windows in lines. 

Horizontal Pixel Offset 
Sets the horizontal position of the source window in Pixels. 

Vertical Line Offset 
Sets the vertical position of the source window in Pixels. 

SDI X Connector Scalar Profile 

Allows you to select a list of pre defined output modes based on the current main video mode and the  
windows Size.  

Manual offset 
Manual offset allows you the position the source window, vertically by 1 line 
increments and horizontally by 1 pixel increments via LMB Clicking the directional 
arrows. 
The center button will center the Source Window based on the Video mode and the 
Main Video Window sizes. 

 
 
 

12.3.4 SDI X Workflow – 2K to HD 
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In the following example, Symmetry is playing back 2K x 1080 @ 23.98 FPS with 10-bit RGB DPX log in 4:4:4 
Dual Link mode. 
 
HD 1920 x 1080 59.97 is the desired SDI X output in YUV. 

 
• A 2K x 1080 video mode is the main video mode.  
• SDI A and B are in Dual link 4:4:4 and outputting 4:4:4; 10 bit RGB in log at 2K x 1080 @ 23.97 fps. 
• The Video processor is provided a 2K 1080 frame. 
• The position is fixed as the main video mode and the Source Window is equal. 
• A 1D LUT is provided to convert 10 bit LOG to 10 bit Linear YUV. 

 

Workflow 2K to HD – Visual Flow 

 
 
 

2048 

1080

1080

2K frame at 23.97 Psf is DMA to 
the 2K lust via memory or via SDI 
4:4:4 or HSDL 

A window is selected for 2048 x 
1080 frame size. 
(Full Frame) 

The windows is automatically 
centered  

The final result output via the SDI 
X scaled to HD 1920 x 1080 @ 
29.97 letterbox via hardware 3:2 
pull down.  

2048 

1080

1920 
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Workflow 2K to HD - Block Diagram 

 
 

2K x 1080  
4:4:4  

DPX Log  

SDI A 

SDI B 

1920 x 1080  
@ 59.94 
Letterbox 

 
2K x 1080 frame 
10 bit RGB Log 

 

Crop

Scale

Window Size is set to 2K x1080 

Position
Window Position is default centered 
as the Window size and the main 
video is equal

A 1920 x 1080 @ 59.94 profile is 
selected for SDI X output preview 

Video 

SDI X 

2K x 1080 frame 
10 bit RGB Log 
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12.3.5 SDI X Workflow – 2K to HD Crop & Scaled to NTSC 

In the following example, Symmetry is playing back 2K x 1080 @ 23.98 FPS with 10-bit RGB DPX log in 4:4:4 
Dual Link mode. 

 
SD NTSC 29.97 is the desired SDI X output in YUV. 
A 2K x 1080 video mode is the main video mode.  
SDI A and B are in Dual link 4:4:4 and outputting 4:4:4; 10 bit RGB in log at 2K x 1080 @ 23.97 fps. 
The Video processor  is provided a 1920 x 1080 frame providing a crop of the 2K 1080 frame. 
The position is centered and a NTSC scale profile is selected. 
A 1D LUT is provided to convert 10 bit LOG to 10 bit Linear YUV. 

2K to HD Crop & Scaled to NTSC - Visual Flow 

 
 

2048 

1080

1080

2K frame at 23.97 Psf is DMA to the 
2K lust via memory or via SDI 4:4:4 
or HSDL 

A window is selected for 1920 x 
1080-frame size. 
The 2K 1080 frame is cropped  

The HD 1920 1080 window is 
centered automatically by 
application 

The result is outputted via the SDI 
X, scaled to NTSC @ 29.97 
letterbox via hardware 3:2 pull 
down.  
 

1920 

486

720 
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2K to HD Crop & Scaled to NTSC - Block Diagram 

2K x 1080 
4:4:4 

DPX Log 

SDI A 

SDI B 

NTSC  
@ 29.97 

(Letterbox) 

2K x 1080 frame 
10 bit RGB Log 

 
2K x 1080 frame 
10 bit RGB Log 

Crop

Scale

SDI X 

Window Size set to 1920 x1080 

Position Window Position is centered as the 
Window size and the main video is
A NTSC @ 29.97 profile is selected 
for SDI X output preview 

Video 
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13 Audio  
The Bluefish444 2K/HD product range Supports 8 Channels of SP Dif BNC unbalanced External Audio. 
24 bit at 48 KHz. 
 

Digital Audio I/O 

AES/EBU/SPDIF Output Ch 1&2 

AES/EBU/SPDIF Output Ch 3&4 

AES/EBU/SPDIF Output Ch 5&6 

AES/EBU/SPDIF Output Ch 7&8 

AES/EBU/SPDIF Input Ch 1&2 

AES/EBU/SPDIF Input Ch 3&4 

AES/EBU/SPDIF Input Ch 5&6 

AES/EBU/SPDIF Input Ch 7&8 
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14 3rd Party Software Setup 

14.1 Adobe Production Studio 

Bluefish444 continues to support Adobe solutions with direct support for Adobe Premiere Pro 2.0, Adobe After 
Effects 7.0, Adobe Audition 2.0 and Adobe Photoshop CS2. 
 
Adobe Production Studio Certified plug-ins. 

14.2 Adobe Premiere Pro CS3 & 2.0 

Bluefish444 continues to support Adobe Premiere Pro CS3/2.0 with real-time playback preview of effects and 
supported 3rd party file formats with adjustable quality supported in Premiere Pro CS3/2.0. Effects and transitions 
are rendered only on export to maintain true 10 bit YUV uncompressed quality to your workflow. The range off 
effects previewed in real time is system dependant. 
Bluefish444 has also added the ability to playback any supported file format, either uncompressed or compressed 
(dependant on system performance) that can be imported by Premiere Pro CS3/2.0, such as AVI, TGA, Jpeg, Tiff 
and QuickTime etc. 
Once again rendering the timeline during editing and playback is no longer required, only for intensive effects and 
during exporting to tape. 
Playback performance is scalable, so as Premiere Pro CS3/2.0 and system performance increases, so does the 
ability to add more streams of video, audio, stills, effects and transitions. 
 

 
Bluefish444 have also added an offline capture module providing the ability to digitize to DV-AVI compressed file 
format via SD SDI or SD analog sources. At approximately 1/10th the file size of uncompressed SD 10 bit YUV 
v210 QuickTime files, makes it a perfect solution for SD or HD offline editing in conjunction with the project trimmer 
feature. Not only is the quality incredible but it is also compatible with Premiere Pro DV editing mode. 
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Note; Bluefish444 Premiere Pro 2.0 plugin’s are not compatible with earlier versions of Adobe Premiere Pro.  
 
Adobe Premiere Pro 2.0 also supports serial VTR deck control. Serial VTR control is support via the COM port not 
the Bluefish444 VTR ports. You can use the same VTR cable supported by Symmetry shipped with the Bluefish444 
hardware 

14.2.1 Adobe Premiere Pro CS3/2.0 Features 

HD and SD 10 bit YUV uncompressed editing with the multiplatform QuickTime v210 file format 
Real time capture and playback in High Definition and Standard Definition in 10 bit uncompressed YUV 
QuickTime v210 file format. 
Supports real time playback of imported QuickTime v210 files generated from 3rd  party QuickTime supported 
applications with our 10 bit YUV QuickTime v210 codec. 
Preview in capture, playback and monitor windows. 
Multiple audio channel output support and management features for 5.1 surround sound monitoring. 
Support for CGR and Non CGR editing modes. 
Extended support for optional P and Psf output option 
Full support for SD and HD color matrix conversion. 
Premiere Pro and After Effects dual mode support. 
Accelerated MPEG 2 encoding with Adobe Media encoder with RAGE N|Code  
HD and film offline editing with EDL export to Symmetry for 10 bit RGB conforming and DI. 

14.2.2 Advanced Playback Options. 

Bluefish444 has added two professional features to Premiere Pro 1.5 accessed in the Playback settings in the 
General Preferences of the Project Settings. 

14.2.3 CGR and SMPTE matrix color range. 

This feature enables Premiere Pro CS3/2.0 to work in CGR and SMPTE color range during playback. 
 
If your source data contains super white or super black i.e. the full RGB color range of 0 to 1024 you may wish 
to maintain these values through out the editing process. this can be achieved by using the “CGR Matrix 
Range”. 
If your source does not contain super whites and super blacks i.e. color range of 64 to 960, then you may wish 
to use the “SMPTE Matrix Range”. CGR Matrix Range = maintains super blacks and whites, 0 to 1024 SMPTE 
Matrix Range = maintains SMPTE color range, 0 to 960. 

 

14.2.4 P/Psf mode. 

When editing in HD modes Bluefish444 enables Premiere PRO CS3/2.0 to capture and playback 1080P 
(Progressive scan) modes. 1080p 23.976, 24, 25 and 30 frame per second progressive footage cannot be 
monitored on broadcast monitors because the vertical refresh rate would be too low. To get around this 
problem and allow progressive material to view on a standard broadcast monitor “psf” was devised. This sends 
the progressive frames down the cable odd lines first then even lines, i.e. like two ‘pseudo fields’ as if it were 
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an interlaced signal. The material is progressive (i.e. all lines in the frame were captured at the same instance 
in time. Therefore, to avoid possible confusion the ‘progressive fields’ are referred to as “segments”. 
Consequently, we use the abbreviation “psf” for “Progressive Segmented Frame”. 
 
720p 59.94 and 60 video modes do not need a psf option because the vertical refresh rate is already fast 
enough to display on a standard broadcast monitor. 
 
Bluefish444 provides two presets, both defaults to psf mode when opened. 
Bluefish444 HD 1080 23.967 
Bluefish444 HD 1080 24 
 
If you wish to change the video mode on the cable to P (progressive) you can do so by opening up the project 
settings, selecting general and then the playback options tab next to the time base drop down list. 

14.2.5 Real Time Playback Monitor 

14.2.6 Supported Broadcast Modes. 

14.2.7 Supported Video Modes 

2K 

• 2K Video modes are not supported by the Bluefish444 hardware and Premiere Pro 2.0 and CS3 

High Definition. 

• 1080i 25fps, 1080i 29.97fps, 1080i 30fps. 
• 1080p 23.98fps, 1080p 24fps, 1080p 25fps, 1080p 29.97fps, 1080p 30fps. 
• 1080psf 23.98fps, 1080psf 24fps 
• 720p 59.97fps, 60fps. 

Standard Definition. 

• NTSC 720h 486 29.97fps. 
• PAL 720h 576 25fps.6 

Preview Playback Drop Frame 
RED = Preview has dropped frames 
Green = Preview has not dropped frames

NON Real Time Indicator 
RED = Effects are not processed in real time 
Green = Effects processed in real time 
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14.3 Setting up Premiere Pro CS3/2.0 

Premiere Pro 2.0 screen shots are used in this manual. 

14.3.1 Scratch Disks. 

The first thing you are required to do is set up your scratch disk. 
This should be your fastest drive configured to support the video and file format you intend to capture and 
playback with. 
When mixing formats such as clip formats and sequential formats, performance drops caused from 
fragmentation will need to be taken into account with your storage solution. 
 
For further information on storage solutions see Appendix C Storage Arrays and Configurations. 
Alternatively refer the hardware . 
 
Ensure that the preferences settings are correctly setup for you scratch disks and the paths are directed at a 
valid Media Disk array that can sustain the data rate for real time playback for HD or SD modes. 
You can do this via selecting Edit -> Preferences -> Scratch disks. 
Ensure all paths point to your Media array. 
 

14.3.2 Audio  

Bluefish444 provides support for 48 KHz uncompressed multi channel audio support via the audio interface of 
the Bluefish444 HD and SD product range. All audio playback is output via the Bluefish444 hardware. 
 
Bluefish444 provides full support of Multi channel and surround sound 5.1 audio monitoring. Provides full audio 
routing support providing support for channel to track routing.  

Enabling the Audio driver. 
In the Adobe Premiere Pro menu bar select EDIT -> PREFERENCES -> AUDIO HARDWARE. 
In Audio Hardware section, select the input/output drop down list and select “Bluefish444 ASIO”. 
Select OK. 

Using other sound card devices. 
Monitoring through other 3rd party sound cards or devices is not recommended, video and audio sync is not  
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guaranteed and you may experience audio delays and in consistencies in audio playback. 

14.3.3 Surround Sound Monitoring and Routing. 

Bluefish444 supports Adobe Premiere’s 5.1 surround sound output.  
You can assign certain tracks on the timeline and route them to specific channels via the Bluefish444 
hardware. 
 

1. Start a new sequence. 

2. In the Audio master drop down list set master to 5.1. 

3. Select OK. 

4. Go to Edit then Preferences and select Audio Hardware. 

5. For Input/output device select Bluefish444 ASIO option. 

6. You will be presented with a range of information in the Output Channel Mappings. This allow you to 
map the 5.1 sound channel outputs (Left front and rear, right front and rear and centre) to the physical 
audio outputs of the Bluefish444 hardware. 

7. Open up the audio mixer interface. 

8. On the Menu bar go to Window -> Audio Mixer to load the Audio mixer interface. 

9. You will be presented with a window similar to the following. 

 
Each track on the timeline is mapped to a specific audio section in the Audio mixer interface. For example 
Audio1 on the timeline corresponds to Audio1 in the audio mixer. 
 
For the example in the diagram below, the audio file in track one of the timeline will be mapped to the left 5.1 
audio channel which is mapped to the Bluefish444 AES/EBU out 1 channel. If you lay another audio track in 
Audio2 in the timeline that will be mapped to the right 5.1 audio channel which is mapped to the Bluefish444 
AES/EBU Out 2. 
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14.3.4 Multiple Audio Channel Output. 

Alternatively, you can assign one track to output to all audio channels of the Bluefish444 card. 
This is done by simply centering Audio 1 section, which is linked to the Audio 1 track on the timeline. By 
centering the control point in the center, you are effectively telling Premiere to route the audio on track 1 in the 
timeline to all available Bluefish444 audio channels 

 
For further more detailed information on the Audio features and controls for Adobe Premiere Pro 2.0/CS3 
please refer to the manual. 

14.3.5 Deck Control 

Premiere Pro Ships with built in VTR control. 
Ensure that you use a RS 232 to RS 422 converter for accurate Deck control and layoff. 
Select Serial VTR under Device control  
For more information, please refer to the Adobe Premiere Pro 2.0/CS2 manual for deck control settings. 
For Deck Calibration, please refer to the Appendix A - Adobe Premiere Pro Serial Deck Control Collaboration.  
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14.3.6 Capturing with Premiere Pro CS3/2.0  

Bluefish444 have developed two capture module plug ins that are selectable in Project settings,  
Capture options are; 
 
Bluefish444 recorder =   QuickTime 10 bit YUV uncompressed 
Bluefish444 DV record =   DV AVI Compressed  
 
Each module is selectable in any edit mode supported by Adobe Premiere Pro as long as the captured 
resolution and frame rate is the same. 
 
For example when you are in PAL DV mode you can capture to DV format via the Bluefish444 capture card for 
video and audio by selecting the Bluefish444 Record DV capture module. If you desire to capture QuickTime 
10 bit YUV v210, select Blueffish444 record. 
 

When selecting a preset, Premiere Pro 2.0 will default to Bluefish444 record, which will digitize to QuickTime 
10 bit YUV uncompressed file format. 
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14.3.7 Exporting a Movie to Bluefish444 10 bit YUV v210 QuickTime. 

In some cases you may wish to export your sequence to other media such as Windows media 9 or MPEG 2. or 
you may wish to export your movie to another Bluefish444 and Adobe Premier Pro solutions 
If you wish to export to Bluefish444 QuickTime v210 you will need to select the File type to Bluefish444. 
 
Select File -> Export -> Export to Movie. 
 
Here you will have an option to name a file and choose a location. 
 
Select the settings button. 
In the file type drop down box select Bluefish as the file type. 
Click on OK to start the process. 
 
Alliteratively you have the option to export your movie to a variety of file formats. 
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14.4 Adobe After Effects CS3/7.0 

(Application Software not included) 
 
Animate your ideas. Adobe® After Effects® 7.0 software helps you create compelling motion 
graphics and blockbuster visual effects with efficiency, precision, and infinite variety. Take 
advantage of unmatched integration with other Adobe software, flexible 2D and 3D compositing, 
and hundreds of effects and Animation Presets to bring a new dimension to your film, video, DVD, 
and Macromedia® Flash® productions.  
 
 
 
 

• HD and SD Broadcast real time monitoring  
• Real-time playback via RAM player  
• 8 and 10 bit RGB frame buffer support 
• 8 and 10 bit project mode support 
• Dedicated QuickTime v210 exporter 
• Real-time SD and HD color space conversion 
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14.4.1 Setting up Adobe After Effects CS3/7.0. 

Adobe After Effects requires no settings to enable video monitoring support. This feature will automatically be 
enabled once a supported composition setting is selected. 
 
Supported Broadcast Output modes 

 
Video Mode AE 7 preset Supported Video Mode and frame rate 

HD 1080  HDTV 1920 x 1080  1080i 25fps, 1080i 29.97fps, 1080i 30fps.1080p 23.98fps, 1080p 
24fps, 1080p 25fps, 1080p 29.97fps, 1080p 30fps.1080psf 
23.98fps, 1080psf 24fps, 1080psf 25fps.  

HD 720  HDTV, 1280 x 720  720p 60fps, 59.97fps.  

SD PAL  PAL D1/DV, 720 x 576  PAL 720h 576 25fps  

SD NTSC  NTSC D1, 720 x 576  NTSC 720h 486 29.97fps  

14.4.2 Enabling Video monitoring output 

1. Create a new project 

2. In the Menu bar, select Composition, 

3. In the Basic tab, select a supported AE 7 preset  

4. IN the composite windows, set the composite resolutions settings to full.  

If you wish to utilize more memory for animation and motion effects then you can reduce the composite 
resolution to half or a quarter. This will disable the Bluefish444 preview with in After Effects.  

14.4.3 Changing Bit depths. 

After Effects can now take advantage of 10 bit RGB frame buffer video preview modes when in 16 bit project 
modes. 
 When in 16 bit project mode After Effects will provide a 10 bit RGB frame and output to10 bit 4:2:2 or 10 bit 
4:4:4  
 
To change project modes ( Bit Depths) Via the interface. 
 
Hold down the Left ALT key on your keyboard and at the same time select the 8 bpc text in the After Effects 
project Bin. 
Each click will switch between 8 and 16 bit project modes. 
 
To change project modes ( Bit Depths) Via project Settings. 

 
Go to the menu bar and select File -> Project Settings 
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Select the color depth of your choice in the color depth drop down box. 

14.4.4 Real Time Playback 

You can achieve real time playback of your timeline using After Effects RAM player feature. Adobe After 
Effects utilizes how much ram you have on your system. So the golden rule of thumb for compositing 
especially in HD is more the better. 
Make sure you select the frame rate that corresponds to the frame of your composite settings. Depending on 
the resolutions size of your Desktop preview window in After Effects can affect playback performances as a 
larger frame has to be written to the desktop. 

14.4.5 Exporting to QuickTime with After Effects. 

If you wish to export your projects into Premiere Pro 2.0 for real time playback you can use the Bluefish444 
QuickTime Exporter plug in 
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NOTE, Premiere Pro and Symmetry will not support QuickTime files rendered from After Effects with the After 
Effect QuickTime Movie exporter via the Bluefish444 v210 codec. You must use the Bluefish444 QuickTime 
Exporter. 
This is due to After Effects not guaranteeing QuickTime moves on a specific byte boundary that is required for 
RT playback in Pro 2.0. This is more apparent in HD resolutions than SD resolution QuickTime files. 
 
Alternatively if you do not intend to use Premiere Pro, render to the Cineon format and then import fro file 
sequence into Symmetry for exporting to tape.  

14.4.6 The Bluefish444 QuickTime export plug-in. 

This plug-in allows you to export to the QuickTime v210 file format that supports Premiere Pro 2.0, Quick Clip 
Pro and Symmetry for real time playback  
 
Using the traditional QuickTime Movie format  export via the Bluefish444 codec is not support fro playback in 
Premiere Pro 2 
 
The Bluefish444 exporter will not support embedding of audio, the exporter is for video only. Simply export 
audio only as a separate pass from your same composition to a 16 bit 48 KHz wav file. 

Frame rate. 

The frame rate here should always match the composite settings and the broadcast mode you are using. 

Scan Mode. 

• Interlaced 
• Progressive. 

Conversion Matrix. 
CGR. 
 
Color space conversion between Standard Definition YUV and “Full Scaled” RGB (8 bit: 0 - 255, 10 bit: 0 - 
1023). 
When rendering with CGR enable you maintain the full color levels. Video safe colors are ignored. 
 
SMPTE. 
 
Color space conversion between YUV and “SMPTE Scaled” RGB (8bit: 16 - 235, 10bit: 64 - 940). 
 
When rendering with SMPTE enabled, video safe colors are supplied. 

Rendering with Bluefish444 QuickTime Export plug-in; 
1. In the After Effects menu bar 

2. Select Composition -> Make Movie 

3. Go to the Current Render Details section of the Render Queue Dialog Box. 

4. In the Output Module section, select the “Lossless” option text and it will open the “Output module. 

5. Select Bluefish444 QuickTime in the Format drop down list 

6. A Dialog box called Bluefish v210 Encoder will open. 

7. In the Video output sections select Format options button. 

8. Enter your frame rate equal to that of the composition you are exporting. 

9. Select the scan type as either Interlaced or Progressive 

10. Select the RGB/YUV matrix you wish to use. 

11. Select the X to close the dialog box 

12. In the Output To section select the *.MOV option text and enter a file name and path to render you 
QuickTime movie to. 

13. Select Render to begin the render process. 
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14.5 Sound booth 

(Application Software not included) 
 
Record, mix, edit, and master digital audio files with powerful tools that bring flexibility and control 
to your desktop studio. Easily create music, produce radio spots, and restore imperfect 
recordings. Bring audio and video together using smart integration with Adobe video applications. 
Get professional results in real time with Adobe® Sound booth software. 
 
 
 
 
 

 
• Monitoring of uncompressed audio channels equal to the Audio selected output. 
• Support 48000Khz monitoring 
• channels of AES/EBU (Balanced, XLR) or 
• Channels of AES-3id (Unbalanced, BNC) or 
• 2 channels 0dBu (Balanced, XLR) or 
• 2 channels -10dBu (Unbalanced, RCA) 

 

 
With support for ASIO audio interface now supported by Audition 2.0,  Adobe and Bluefish444 customers have 
the ability to monitor audio output on the same system with up to 8 channels of audio, perfect for  5.1 and 7.1 
surround sound audio editing 

14.5.1 Setting up Adobe Sound Booth 

1. Select Edit in the menu TAB 

2. Select Audio hardware Setup 
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Under the following tabs; Edit View, Mulitrack View and Surround Encoder, change the Audio Device to 
Bluefish444 ASIO. 
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14.6 Photoshop CS2 

 
Bluefish444 Photoshop Exporter adds an important plug in for broadcast graphic designers 
by allowing you to quickly see your Photoshop images through any Bluefish444 video card. 
This is important for checking color, positioning, line width, and other graphic issues that can 
change when moving images from a VGA to a broadcast monitor. 
 

 

 
 

• Support for NTSC, PAL, HD720p, and HD1080i. 
• Pre built actions for hotkey updates. 
• Plug-in outputs both the image and the alpha channel on dual-link cards. 
• Support for 8-bit and 16-bit images. 
• Automatic YUV conversion. 
• Support for ALL Bluefish444 cards. 

14.6.1 Using Actions with the Bluefish444 exporter 

Bluefish444 exporter plug-ins includes an Action preset file called Bluefish444.atn which is loaded to the 
Photoshop actions folder in the installed folder. 
Actions can be can be linked to the Bluefish444 export plug ins by assigning keyboard Shortcuts 
 
To load and assign shortcuts the Bluefish444 actions. 
 

1. Open up the Actions dialog box and select the Options arrow button. 

2. Select the Bluefish444 option. this will load the Bluefish444 pre defined actions to the Actions Pallet. 

3. Select an Action, say “TFT - Bluefish444 NTSC Export”, select the options arrow button. This will 
option the dialog side bar as before. 

4. This time select the Action Options The action dialog box will open. 

5. In the function key drop down list, assign a function Key of your choice. 

6. Click on OK. 

7. Now open up a project in NTSC then select F5 and you will see the project window output to the 
Bluefish444 SDI/Analog output on your broadcast monitor. 
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14.7 Fusion 5.X 

Eyeon provides SD and HD frame buffer support for Fusion 5.X and Bluefish444  
Fusion supports real time playback via the Bluefish444 video output cards vai RAM 
player cache and real-time preview 
Fusion supports 8 bit and 10 bit RGB modes 
The plug ins shipped with the Digital Fusion software and will automatically be a listed 
option in the I\O preferences tree if a supported Bluefish444 card is installed. 

 

 

14.7.1 Setting up Digital Fusion 5.X 

Frame buffer monitoring Global 
1. Load Fusion and close the composition flow that loaded as default 

2. In preferences, expand the “Global and new comp defaults” 

3. Under I/O select the Bluefish444 option 

4. Select the Video standard you wish to output, the card installed will depended on the listed modes 
you can use 

5. For 10 bit support select the 10 bit option 

6. For 8 bit support deselect the 10 bit option. 

7. To switch between RGB and YUV mode, toggle YUV option 

14.7.2 Path settings 

1. In Preferences, expand the “Globals and new comp defaults” 

2. Select Path Map option. 
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3. Change the following Path Maps options to your certified array for RT SD and HD payback; 

a. DiskCache 

b. Previews 

14.7.3 Node monitoring 

Generate a new composition flow and add a loader node and attach a CC node. 
Ensure the Output settings equals the composition resolution in the preference settings 
Right click the CC node and select the option arrow for View On and select the Bluefish. 
Select Play. Fusion will render and cache to RAM  until all the available RAM is used. Real time preview will 
occur after the first render pass. 

14.7.4 Preview  

Fusion will default to creating a pre view in the preview paths folders that is set in the preferences section. 
This path along with all other paths should be pointing to the fasted array for your projects 
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1. Right Selecting the CC Node, Select the option arrow for Create/Play Preview on, 

2. Select Bluefish444 option  

3. The render setting dialog will pop up 

4. Select your desirable options 

5. Select Start Render. 

6. Fusion will render to the Array to the Preview folder 

14.8 Combustion 4.0 

Bluefish444 provides SD and HD frame buffer support for Autodesk compositing application. 
Frame buffer support is 8 bit RGBA with option to pre multiply the alpha in HD and SD video modes. 

14.8.1 Setting up Combustion 4.0 

1. Launch Combustion 4 

2. Under preferences, select frame buffer 

3. Under frame buffer type, select Bluefish444 

 

 
To change the video monitoring output to match your composition, select options 
Select the available Resolutions supported via the bluefish444 card 
To use with RAM player select the option to enable. 
 
RAM player preview will be real time after the first render PASS to RAM 
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14.9 The Onboard Keyer 

The onboard keyer feature provide the use the ability to overlay over the input signal  in real time with any frame 
buffered image or frame generated from applications that support RGBA. 
This provides studios and live broadcast environments the ability to brand transmissions, perform logo insertions 
and output copyright signals to tapes etc   
Symmetry will be supporting TGA sequential playback which also can be used to playback sequences for internal 
keying. 
Note; you can not capture when onboard keyer is enabled. 

14.9.1 How to use the onboard keyer 

1. Connect the output of the Bluefish444 card to a valid SDI monitor 

2. Connect the HD card Genlock input to a sync reference via the SDI cable. ( use the deck reference) 

3. Launch the Bluefish444 feature application tool and enable the onboard keyer in the Misc functions 
section of the feature application. 

4. If the image is positioned incorrectly, adjust the horizontal and vertical timing adjust by adding a value 
and pressing “SET” 

5. Launch your supported digital content creation tool, for example Adobe After Effects. Set the 
composition resolution and frame rate to the input of the source you wish to overlay. 

6. You should see the input source outputted to the SDI monitor. 

7. Create some content like text, the text will be overlaid in real time. 

8. You can also create an animation loop by loading the animation to RAM player and looping the 
playback. 

Ensure to turn the Onboard keyer feature off if you intend to use it with other applications that require input 
functionality such as Symmetry and Adobe Premiere Pro. 
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15 1 4BSupport.  
Bluefish444 provide unlimited email and phone support to all registered customers for the life of the products warranty. 
 

World Wide Support  
 
HUsupport@bluefish444.com U 
 
 
Australasia / APAC  
 
Bluefish444 Head Office  
9am to 5pm (GMT+10 hours) 
T: +61 3 9682 9136 
Email: HUsupport@bluefish444.com U 
  
 
North America 
 
USA Tech Support 
T: 1-866-314-7785 - Select option 2 
HUsupport-usa@bluefish444.comU 
 

Europe 
 
Bluefish 444 Europe Ltd 
Joel Street Farm, 
Joel Street, Pinner, 
Middlesex, 
HA5 2PD. 
United Kingdom 
 
T: +44 (0)20 8429 8345  
F: +44 (0)20 8866 8207 
Email: HUsupport@bluefish444europe.com U 
 
 
 
 
 
 
 
 

 
In order to resolve your issues quickly please ensure that you provide the following information when contacting support. 
 

• System configuration and manufacture, Mother board type and Devices installed. 
• SCSI or RAID controller card type. 
• Storage array configuration, 
• OS version. 
• Applications installed 
• Bluefish444 Serial number and product type. 
• Installer version. 
• Contact number 
• Company name 

 
We recommend using MSINFO32 for a detailed list of system information 
 
Start Menu -> Run -> msinfo32 -> press enter -> select Export. 

15.1 Technical Support Section 

This section is for registered users. 
 
Provides Information on; 

• latest support issues 
• Legacy Driver Downloads. 
• Workflows. 
• Online ordering and purchases 

 
 

15.2 Support Resources 

A list of frequently ask questions listed by application type. 
Link http:\\www.Bluefish444.com\support\FAQ. 
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15.3 Hardware Compatibility Guide. 

This site has detailed information on tested and certified hardware categorized by motherboards, systems and integrators. 
Link http:\\www.Bluefish444.com\support\compatability. 

15.4 Software Compatibility Guide. 

Current list of released retail software that is compatible with the Bluefish444 product range. Refer to this site often as new 
supported products a frequently released. 
Link http:\\www.Bluefish444.com\support\compatability. 
 
For phone support you must register your product online at the Bluefish444 web site. 

15.5 Tech Support 

If you have any questions please contact support at Usupport@bluefish444.comU.  
Email Support is free for the life of the warranty.  For phone support you must register your product at 
http://www.bluefish444.com/support/techsupport.   
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16 Contact 
 

Australia 
 
BlueFish444 (Head Office) 
 
17b Market Street,  
South Melbourne 
Victoria, 3205 
Australia  
Telephone:+61 (3) 9682 9477 
Facsimile: + 61 (3) 9682 9466 
Email: HUinfo@bluefish444.comU 

Europe  
 
Bluefish444 Europe Ltd, 
 
Joel Street Farm, Joel Street,  
Pinner, 
Middlesex, 
HA5 2PD. 
United Kingdom 
 
Telephone: +44 (0)20 8429 8345  
Facsimile: +44 (0)20 8866 8207 
Email: HUGDavis@bluefish444europe.com UH 
 
Web: HUhttp://www.bluefish444europe.com U 

North America  
 
Channel Wolves 
 
236 Huntington Avenue  
Suite 216  
Boston, MA 02115 USA  
Telephone: 1-866-314-7785  
Facsimile: 1-617-249-1733  
Email: contact@channelwolves.com 

Web http://www.channelwolves.com 

 

China 

UBS Consulting  
 
601, Block 4, Wanda Square.  
93 Jianguo Road 
100022  
Beijing P.R  
China 
Telephone: +86 (10) 5820 6929, +86 1350 1287 
726 
Facsimile: +86 (10) 5820 6930 
Email: HUservices@ubschina.comU 

HUWeb U H HUhttp://www.ubschina.com/bluefish/ U 
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17 Appendix A - Adobe Premiere Pro Serial Deck 
Control Calibration. 

 
The following steps can be used to accurately calibrate the serial deck control plug in for capture and export to tape with 
Premier Pro 
 
Please note the settings and offset values used in this example may vary with different decks. 
Ensure you follow the steps below to determine the values for your particular configuration 
 
Ensure that you have a RSs 232 to RS 422 converter when using Premier Pro Serial VTR control. 
 
Step 1 Striping a tape with time code 
Step 2  Prepare test footage with embedded time code 
Step 3  Capture Offset Calibration 
Step 4  Export to tape calibration 
Step 5  Adjust export to tape settings. 
 
Step 1 - Format a tape with time code: 

1. Recommend using a blank tape, insert into the deck 

2. Remove any input SDI signal to the deck and change the input signal as internal and black. 

3. Reset the time code to 00:59:00:00 

4. Begin recording, usually pressing PLAY + REC does the trick. (Refer to your deck user manual to start a force 
record).  

5. Stop recording after 5 minutes, this should take you to 01:04:00:00) 

6. Make sure you reconnect the SDI input to the deck and change the input to SDI. 

 
 
Step 2- Generate a reference video clip with burnt in time code. 
 
This can be achieve by using any application that can render out to the Bluefish444 v210 QuickTime codec 
Alternatively you can download the calibration kit as pre rendered video or as a Premiere Pro CS3 project to be rendered 
out. 
 
Duration only needs to be 1 minute long so keep it small. 
Download at. http://www.bluefish444.com/support/downloads/utilities.html. 
 
 
Step 3 Capture Offset Calibration 
 
Capture offset calibration needs to performed before Export to tap calibration. This is because we require accurate capture 
to calibrate export to tape. 
 
Ensure the deck is set to overlay Time code on the SDI monitor. Most decks come with a monitor output, which will show the 
time code from the deck on the SDI display an overlay to the video. 
 
We now need to offset the deck to match the IN point and the first frame of the calibration footage. First, we do a capture of 
the SDI source with Time code. 
 

1. In Premiere Pro Capture window, select your project as either NTSC or PAL ( or whatever your desired video 
resolution and frame fame you wish to work with) set your IN point to capture to a whole number that is easy to 
read; for example;  

IN = 01:01:10:00,  
OUT = 01:01:40:00,  

2. Select Capture IN\Out in the PPRO capture window. Premiere should digitize to the bin a clip 30 seconds long. 

3. Load the clip into the time line. 

4. Go to the first frame of the new captured clip and note the difference of the captured Time code.  



 

85 
 

2K/HD Manual 

 
 

5. This example the time code reads 01:01:10.4 +4 frames; it should read 01:01:10.00 so the deck needs to be offset 
by 4 frames. 

6. If the first frame of your captured clip is the same as the In point, then you require no offsets. 

7. Add these values in the Capture -> Settings -> Device Control -> Time code Offset.  

For our example, it will be 4 frames. (See Following Diagram) 
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Step 4 - Export Calibration 
 
To have accurate tape exporting you need to adjust the play timing and the edit timing, this requires a bit adjusting until it is 
accurate. 
 

• Adjusting play timing removes the repeated frames you may experience 
• Adjusting the manual edit timing will offset the deck when it starts to record and the video signal from the 

Bluefish444 card 
 

1. Firstly, import the footage from Step 2 into the timeline.  

2. Make sure that the tape you are using is formatted with the correct time code equal to the video mode and frame 
rate you are using, see Step 1 above. 

3. Rewind the tape to 01:01:00:00. 

4. Select the test footage on the timeline. 

5. Select export to tape, File -> Export -> Export to tape. 

6. Select Assemble. 

7. Enter a value 01:01:00:00 as an IN Point. 

8. Duration should take into account the clip length you have select ( 1 Minute). 

9. OUTPOINT therefore should be set to 01:01:01:00. 
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10. Select V, A1 and A2. 

11. Select Options. 

12. Ensure the correct “Hard record frame control” is set to the proper frame mode for you set up. 

a. Drop frame. 

b. Non drop Frame. 

13. For pre roll use 5 seconds.  

14. Sync record on. 

15. Manual edit timing = 0 (We will adjust these values later). 

16. Delay movie start = 0 (We will adjust these values later). 

17. Select OK. 

18. Select Auto EDIT to start the export to tape process. 

 
Step 5 
 
Now we need to review the exported footage and count how many frames are repeated from the IN Point until the actual test 
footage starts appearing and begins to increment i.e. not repeat the first frame. 
 

1. In the capture window type in the IN point time code  as "01:01:00.00". 

2. Step through frame by frame until you do not see repeated frames and\or when the exported footage first appears 
with incrementing time code (i.e. the time code increases from 01:01:00.01 from frame 1, 01:01:00.02 from frame 2 
and so on). 

In the example below the exported footage began to show at the Deck time code 01:01:00.5, 5 frames from the IN 
POINT, This is the Manual Edit Timing offset value. 

At time code 01:01:00.5 the burnt in time code value of the time line footage is 00:00:00.03, the 3 frame offset is the 
Delay movie start value. 
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3. Export the footage again with the same IN point value of 01:01:00.00. 

4. You should have accurate insert point of 00:01:01:00 with matching footage time code at 00:00:00:00.  

See sample below. 

 

Delay movie start value
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